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About This Guide
Before you install Pro/ENGINEER, be sure to read this guide for 
installation instructions. This guide is designed to meet two goals:

• To help you install and set up your license management software

• To help you install and maintain Pro/ENGINEER Wildfire 2.0

The primary audience for this guide is system administrators who are 
installing Pro/ENGINEER for the first time. In general, this guide is 
intended for technical staff members who are experience in application 
installations and have a good understanding of operating systems.

How to Use This Guide
This guide supplements the online instructions that are provided when 
you install Pro/ENGINEER and other PTC products, using PTC.Setup. To 
aid you in the installation process, complete step-by-step procedures are 
provided here. 

Post installation instructions and reference information are also given.

Related Documentation
The following document may be helpful as you use the Pro/ENGINEER 
Wildfire 2.0 Installation and Administration Guide:

FLEXlm End Users Guide, which discusses the third-party license 
management software that is used to distribute Pro/ENGINEER licenses.
xv 



Technical Support
Contact PTC Technical Support via the PTC Web site, phone, fax, or 
e-mail if you encounter problems using your software. For more 
information, see Opening and Tracking a Call to Technical Support in the 
PTC Customer Service Guide enclosed with your shipment. This guide can 
also be found under Related Links on the PTC Web page at 
www.ptc.com/olm/index.htm.

You must have a Service Contract Number (SCN) before you can receive 
technical support. If you do not have a number, contact PTC License 
Management using the instructions in your PTC Customer Service Guide.

Documentation for PTC Products
PTC provides documentation on the product CD-ROM in the following 
forms for Pro/ENGINEER Wildfire 2.0:

• Help Center with context-sensitive Help, a global search facility, and 
quick links to helpful information.

• PTC Customer Service Guide and the Pro/ENGINEER Wildfire 2.0 
Installation and Administration Guide and other books in PDF files. To 
view and print the books, you must have the Adobe Acrobat Reader 
installed.

After you install the PTC Help component, you can drag  from the 
Pro/ENGINEER menu bar to any item on the interface to get Help. To 
access the Help Center, click Help > Help Center.

Feedback to Documentation
PTC welcomes your suggestions and comments on its 
documentation—send feedback to the following address:

doc-webhelp@ptc.com

Please include the name of the application and its release with your 
comments. For online books, provide the book title.
xvi Installation and Administration Guide
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Documentation Conventions
PTC documentation uses the following conventions:

Convention Item Example

Bold Menu paths, dialog box options, 
buttons, and other selectable elements 
from the user interface.

Click File > Save.
Assignee check box.
Click OK.

Courier User input, system messages, 
directories, and file names.

Processing completed.

Courier with less-than 
and greater-than 
symbols (< >)

Variables for which the user 
substitutes an appropriate value

output=<LOADPOINT>
About This Guide xvii 





 1
Overview
This chapter describes the materials in your software shipment and the 
installation utility, PTC.Setup. It also explains what steps to take before 
you install the license server and product software.

Topic Page

What You Receive 1 - 2
Before You Proceed 1 - 3
Receiving Your License Pack 1 - 3
Storing Your License Pack Online 1 - 4
Setting Language Defaults 1 - 4
Using PTC.Setup for Installation 1 - 4
1-1 



What You Receive
PTC (Parametric Technology Corporation) sends the following materials 
related to your software order:

• Shipment Confirmation Letter—Before receipt of your PTC 
software, you receive the shipment confirmation letter via fax or 
e-mail. This correspondence introduces you to the software 
distribution process. The Sales Order Number (SON) is included in 
the letter for new software orders. Instructions are provided in the 
letter for requesting a License Pack using that number. It also contains 
a complete list of the software you ordered and the material being 
shipped.

• License Pack—This pack contains the license codes necessary to 
install the software at your site. Instructions for requesting your 
License Pack are included in the Shipment Confirmation Letter and 
the PTC Customer Service Guide.

• Packing Slip—The packing slip accompanies your shipment and 
references the Sales Order Number (SON). It lists the software you 
ordered and the items that were sent with your software shipment. 

• READ THIS FIRST—This document notifies you of any changes you 
must make, such as machine settings and recommended operating 
system patches. 

• Software CD-ROM—Your order contains one or more software CDs 
for each product you ordered and for each platform on which you 
intend to run the software. Check the labels of your software CDs to 
verify that you have the correct CDs for your platforms.

• Hardware and Software Configuration Notes—To provide the most 
recent information, PTC provides notes on each product CD-ROM 
and on the PTC web site:

Online Hardware Configuration Notes for Enterprise Partners:
www.ptc.com/partners/hardware/current/support.htm

Online Software Configuration Notes for Enterprise Partners:
www.ptc.com/cs/doc/index.htm.

Note
To access the online Software Configuration Notes, a customer 
support account is necessary.

Refer to the READ THIS FIRST document for steps on how to access 
information on the CD-ROM.

• PTC Customer Service Guide—Use this guide for descriptions of 
services from Technical Support, the Customer Care Center, and the 
PTC Web site. 
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• Pro/ENGINEER Wildfire 2.0 Installation and Administration 
Guide—Use this guide for information on license management, 
installation of software, and software maintenance. 

Before You Proceed
Make sure you have your License Pack, which contains the required 
license codes to install your software. 

Note
An online copy of your License Pack is highly recommended. 
Maintaining license information in file format allows you to import 
your license codes using the installation utility, PTC.Setup. Importing 
the file ensures accuracy and eliminates the need to supply the data 
manually.

Receiving Your License Pack
Both new customers and customers who are updating their software 
receive their PTC License Packs by electronic mail. If you do not have an 
e-mail address, the License Pack is sent by fax.

New Software Orders, Reconfigurations
After your order has been processed and shipped, you receive a shipment 
confirmation letter by electronic mail or fax. At that time, you are asked to 
contact PTC License Management to configure the purchased products.

For more information on PTC License Management visit 
www.ptc.com/olm/index.htm.

Maintenance Shipments
You can obtain an electronic copy of your License Pack via e-mail or by 
visiting PTC on the Web.

A License Pack for a maintenance release shipment contains all qualifying 
licenses for the site specified. Depending on your site's requirements, one 
License Pack might contain license information for multiple servers.

Maintenance Release users who are updating their PTC software can also 
request electronic copies of their License Packs using the PTC License 
Pack Generator at www.ptc.com/olm. Click Retrieve existing license 
packs. You are asked to supply your Sales Order Number (SON) and to 
select a license pack type.
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Note
The License Pack information reflects the information in your 
customer order. If your configurations have changed since the 
maintenance release was shipped, contact PTC License Management 
for a new License Pack.

Storing Your License Pack Online
To store your License Pack online:

1. Obtain an electronic copy of your License Pack that PTC sends via 
e-mail. This contains your license codes.

2. Save your License Pack information in a text file in only ASCII 
format. On Windows, you can use Notepad or WordPad as a text 
editor. On UNIX, you can use vi.

Note
The previous step is highly recommended but not required.

Setting Language Defaults
To run the installation utility and Pro/ENGINEER in a language other 
than English, set the value of the language environment variable, LANG, 
before you start the installation. To set the value of LANG, see Setting the 
System Language Environment Variable on page B-21 .

Using PTC.Setup for Installation
You install Pro/ENGINEER and its software components, including PTC 
License Server and PTC software products, using PTC.Setup. PTC.Setup 
is a graphical installation utility with Help. The main screen displays the 
following items:

• The main product group that includes PTC License Server, 
Pro/ENGINEER, Collaboration Tools (on Windows), and Structural 
and Thermal Simulation.

• The secondary product group under Other Products in the 
PTC.Setup product selection screen. This includes PTC Application 
Manager (on UNIX), PTC Distributed Services, PTC Help, and 
Pro/Web.Publish.

Navigation in PTC.Setup is easy. Click the required component on the 
PTC.Setup product selection screen to start the installation. Use the Next 
button to continue. The Next button is not available on the PTC.Setup 
product selection screen. You must select a product to proceed to the next 
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screen. Use the Back button to return to previous screens to make 
changes.

Note
When you begin an installation by clicking on the required 
component, an error message is displayed if the required security 
privileges are not satisfied.

You can access the READ THIS FIRST document, the Pro/ENGINEER 
Wildfire 2.0 Installation and Administration Guide, and the services and 
support information from the Help list. This list is available on all the 
screens of the PTC. Setup installation utility.

Selecting Product Features
In all the screens other than the PTC.Setup product selection screen, click 

 before each of the product components to choose the following 
commands from the list:

• Install this feature—Install the component. 

• Do not install this feature—Do not install the component.  
changes to  if a component is not installed.

• Install all sub-features—If a product component has 
subcomponents, you can install them by selecting this option. The 
icon  changes to  to indicate that the components will 
be installed.

Starting PTC.Setup
If your Windows system has autorun enabled for your CD-ROM drive, 
PTC.Setup starts automatically. If your UNIX system automatically 
mounts the CD-ROM, just load the CD-ROM, change to a directory with 
write permissions, and execute the <cdrom>/setup command where 
<cdrom> is the mounted CD-ROM location of the workstation.

If PTC.Setup does not start automatically, use the procedures in the 
following sections.

Windows
To start PTC.Setup on Windows, choose one of these methods:

• Start Windows Explorer, browse to the CD-ROM drive, and 
double-click the setup.exe icon.

• At an MS-DOS prompt, type the following command:

<cdrom>:\setup.exe

where <cdrom> is the CD-ROM drive letter.
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• From the task bar, select Start > Run, and enter the following 
command:

<cdrom>:\setup.exe

UNIX
To start PTC.Setup on UNIX, follow these steps:

1. Change to a directory where you have write permissions (for 
example, /tmp).

2. At a command prompt, type the following command:

<cdrom>/setup

where <cdrom> is the location of the CD-ROM. In UNIX systems, 
you mounted the CD-ROM to this directory.

3. If a /cdrom directory does not already exist, create one using the 
following command:

mkdir /cdrom

If your UNIX system does not automatically mount the CD-ROM, see 
Loading and Mounting the CD-ROM on UNIX on page B-8  for 
step-by-step instructions.

Generating a PTC.Setup Trail File
You can record your menu selections in the PTC.Setup installation utility 
in a trail file to replay them at a later time. You can use this trail file to 
install the software again with similar settings. Create a trail file by 
specifying the -uilog argument upon startup of PTC.Setup from a 
command prompt.

When starting PTC.Setup with the -uilog argument, a trail file named 
ps_trl.txt.1 is created in the directory from where you started 
PTC.Setup. 

Note
You must have appropriate permissions to write to the directory from 
where you start PTC.Setup.

If the ps_trl.txt.1 file already exists, a new trail file named 
ps_trl.txt.2 is created. Further trail files are named using this 
naming convention.

Windows <cdrom>\setup.exe -uilog

UNIX <cdrom>/setup -uilog
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Replaying the PTC.Setup Trail File
To replay the PTC.Setup trail file, you must first rename the trail file using 
the <filename>.txt naming convention. For example, rename the 
pc_trl.txt.1 file to runme.txt. To replay the trail file, use this new 
file name with the -uitrail argument at the command prompt.

Specify the full path to the runme.txt file so that this file is correctly 
accessed with the -uitrail argument.

You can also specify both the -uilog and -uitrail arguments when 
running PTC.Setup. In such cases, the specified trail file is replayed, and 
at the same time, a new trail file is created that records the menu 
selections during the current installation.

The user interface of PTC.Setup opens by default when you run a trail 
file. You can hide the user interface when replaying a trail file by 
specifying the -nographics argument at the command prompt.

If PTC.Setup goes out of sequence when running a trail file, you are 
prompted for input where the trail file goes out of sequence. If a trail file 
goes out of sequence, you can choose to exit PTC.Setup by setting the 
value of the CONTINUE_FROM_OOS environment variable to false.

Windows <cdrom>\setup.exe -uitrail runme.txt

UNIX <cdrom>/setup -uitrail runme.txt

Windows <cdrom>\setup.exe -nographics -uitrail 
runme.txt

UNIX <cdrom>/setup -nographics -uitrail 
runme.txt

Windows set CONTINUE_FROM_OOS=false

UNIX setenv CONTINUE_FROM_OOS false
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Creating a CD Image of a Customized Installation
You can create a smaller CD image of the PTC products and components 
of your choice from the PTC software CD. You can include 
Pro/ENGINEER with only certain components to customize your 
installation. For example, you can leave out the Pro/TOOLKIT 
component. To create a CD image, specify the -makecd argument when 
running PTC.Setup from the command prompt.

When you start PTC.Setup with the -makecd argument from the 
command prompt, the installation is similar to the normal process. 
Instead of installing the products, an image is created in the specified 
directory.

Disabling File Registration (Windows) 
Pro/ENGINEER objects appear with a PTC icon in Windows Explorer 
because of file registration. If you double-click such an object in Windows 
Explorer, the object opens in a Pro/ENGINEER session. You can disable 
file registration for the Pro/ENGINEER objects when installing 
Pro/ENGINEER by specifying the -nofilereg argument when running 
PTC.Setup from the command prompt.

Windows <cdrom>\setup.exe -makecd

UNIX <cdrom>/setup -makecd

Windows <cdrom>\setup.exe -nofilereg
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Quick-Start Installation
This chapter provides a quick-start approach for experienced users who 
have previously installed license management and product software on 
license server, license client, and node-locked machines. For step-by-step 
installation instructions using the PTC.Setup utility, read Chapter 3, 
Installing PTC License Server, and Chapter 4, Installing and Starting 
Pro/ENGINEER.

Topic Page

Installing Software on a License Server 2 - 2
Installing Software on a License Client 2 - 3
Installing Software on a Node-Locked Machine 2 - 4
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Installing Software on a License Server
If you update your software to a newer release, you must update your 
License Pack. PTC License Server is always the first component to be 
installed. Installation of PTC License Server allows subsequent products 
to locate and use the license information.

Note
You must have the administrative privileges to install the license 
management software on a license server.

Installing FLEXlm
Using the PTC.Setup installation utility, follow this process to install PTC 
License Server, and Pro/ENGINEER on the license server:

1. Obtain an electronic copy of your License Pack, which contains your 
license codes.

2. Save your License Pack information in a text file, ASCII format only. 

Note
This step is highly recommended but not required.

3. To use Pro/ENGINEER Wildfire 2.0, perform license simplification to 
upgrade your License Pack to version 25 or later, if you have not 
already done so. See Simplified License Management Process on page 
A-2 for details.

4. Start PTC.Setup, the installation utility.

5. Install FLEXlm, the PTC License Server, into its own directory.

6. Import the license file from step 2 into PTC.Setup. Note that 
PTC.Setup starts the license server after installation is complete.

Note
Although the procedure is longer, you can manually enter the 
license information listed in your License Pack. If you type your 
license information into PTC.Setup's FLEXlm license editor, you 
can type in the keywords: __HOSTNAME__ and 
__PCTD_PATH__. When you save the license file, PTC.Setup 
automatically replaces _HOSTNAME__ and __PCTD_PATH__ 
with the correct values. For complete details, see Using the 
FLEXlm License Editor on page 3-8.

7. Optionally, the EXTERNAL_NAME attribute in the feature line gives 
you the choice to provide a user-defined name or an alias for a 
floating license-to-run.

8. Supply optional configurations (for example, Windows shortcuts).
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9. Install FLEXlm. The license server starts automatically.

For triad configurations, repeat these steps for Triad Partners 2 and 3.

Note
Upon installation of the first triad partner, an error message
the server could not be started appears. This is normal. 
The triad is operational only if at least two of the three partners are 
installed and started.

Installing Pro/ENGINEER
1. Start PTC.Setup, the installation utility.

2. If the license server is also a license client, install Pro/ENGINEER 
into its own directory.

3. Define the platforms, languages, and components that the product 
software uses.

4. Specify the location of the license file (that is, the server host name). 
Provide the host name, an IP (Internet Protocol) address, or a fully 
qualified domain host name. Host name restrictions are dependent 
on the operating system. Alternatively, specify the location of the 
license.dat file (that is, the full path to the license file).

5. Define the command to run Pro/ENGINEER (for example, proe). No 
file name extension is necessary.

6. Attach or associate the licenses listed within your license information 
file to the startup command so that the product software can read the 
license data on the server specified. Multiple licenses can be attached 
to a single command name.

7. Supply optional configurations (for example, Window shortcuts).

8. Start Pro/ENGINEER.

Installing Software on a License Client
When you are installing Pro/ENGINEER and any of its components on a 
license client, you do not install PTC License Server. Instead, you specify 
the server from which this license client should obtain available licenses. 

1. Start PTC.Setup, the installation utility.

2. Install the product software into its own directory.

3. Define the platforms, languages, and components that 
Pro/ENGINEER will use.
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4. Specify the host name of the server that maintains PTC License 
Server. Provide either the IP address or the fully qualified domain 
host name.

5. Define the command to run Pro/ENGINEER (for example, 
proeWildfire2). No extension is necessary.

6. Attach or associate the licenses listed within your license information 
file to the startup command so that your product software can read 
the license data on the server specified. Multiple licenses can be 
attached to a single command name.

7. Supply optional configurations (for example, Window shortcuts).

8. Start Pro/ENGINEER.

Installing Software on a Node-Locked Machine
PTC License Server is not required on node-locked machines 
(independent workstations) that use counted locked licenses. Using the 
PTC.Setup installation utility, install Pro/ENGINEER and point to the 
node-locked license file.

Repeat the steps listed in Installing Software on a License Server on page 
2-2.

Where Your Software Is Installed
The PTC.Setup installation utility defines and installs software into a 
default installation directory that you can modify for your environment 
during installation.

The default path is as follows:

PTC License Server (FLEXlm), the product software, and any components 
are installed into separate subdirectories within the ptc directory.

Windows C:\Program Files\<productname>

UNIX /system_directory/ptc
where system_directory is platform-specific.
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Installing PTC License

Server
This chapter explains how to start the installation utility, PTC.Setup, and 
how to install PTC License Server so that you can control usage of licenses 
for PTC software products.

PTC uses FLEXlm from Macrovision as its license server. Unless an 
uncounted node-locked license is used, you must install PTC License 
Server before you install your PTC software. PTC License Server is 
included on your CD-ROM. For the latest information about which 
version of FLEXlm is appropriate for your installation, see the READ 
THIS FIRST that is included with your shipment. 

Topic Page

Before You Proceed 3 - 2
Finding the PTC Host ID 3 - 2
Windows Requirements 3 - 2
UNIX Requirements 3 - 3
Installing PTC License Server 3 - 3
Supplying Your License Information 3 - 6
Entering Your License File Information Manually 3 - 8
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Before You Proceed
Before you begin, perform the following steps:

• Check the READ THIS FIRST document for any required machine 
setting changes.

• Obtain the online copy of your License Pack, Version 25 or later.

Note
To use Pro/ENGINEER Wildfire 2.0, you must perform license 
simplification, if you have not already done so. You must use a 
License Pack of Version 25 or later, which is compatible with 
Pro/ENGINEER Wildfire 2.0.

• Review your License Pack to make sure your license information 
accurately reflects your order.

Note
The FLEXlm End Users Guide is available on the Pro/ENGINEER 
CD-ROM.

Finding the PTC Host ID
You can obtain the PTC Host ID by starting PTC.Setup from any PTC 
CD-ROM. When PTC.Setup is started, the PTC Host ID of the machine is 
automatically displayed in the lower-left corner of the main screen.

PTC License Server uses the PTC Host ID to assign license codes.

Note
A PTC Host ID is necessary only when a feature is locked to a specific 
machine or to multiple machines.

To download a copy of the PTC ptchostid utility and to view online 
instructions on how to run this tool, visit the PTC Web site at 
www.ptc.com/olm. Click Determining a Machine’s CPU ID that is 
located on the PTC Global Services Order & License Support page. 
Platform-specific instructions are given.

Windows Requirements
For Windows XP, Windows 2000, and Windows NT 4.0, you must have 
administrative privileges to install PTC License Server.

Your Windows system must use the Windows NTFS (Windows NT File 
System).
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You must have TCP/IP (Transmission Control Protocol/Internet 
Protocol) installed and configured correctly on your Windows system 
before installing the software.

UNIX Requirements
PTC.Setup lets you install the software with either root- or user-level 
privileges. For maximum security, Macrovision recommends that you 
install PTC License Server with root privileges but run the server with 
user privileges. 

Installing PTC License Server
You must install PTC License Server on at least one machine to control 
usage of floating licenses. This machine might not have an installation of 
the product software.

Note
The machine on which you install PTC License Server must have a 
static IP (Internet Protocol) address configuration and not a DHCP 
(Dynamic Host Configuration Protocol) configuration.

License management software is not required for a license client. This 
client requests a license from the server.

During installation, you can click Cancel at any time to stop the 
installation.

To install PTC License Server, perform the following steps:

1. Obtain an online copy of your License Pack and save your license file 
as an ASCII file. For more information, see Receiving Your License 
Pack on page 1-3.

2. Start the PTC.Setup installation utility. The Welcome screen appears 
followed by the PTC.Setup product selection screen. 
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3. Click PTC License Server to start the installation of FLEXlm. The 
Define Installation Components screen appears.
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4. Define the following parameters:

– Destination Folder—Type a destination folder to install PTC 
License Server or keep the default value. The destination folder 
must be new and cannot be an existing folder.

Note
On Windows, you can have only one installation of PTC 
License Server on a machine. When you start installing PTC 
License Server, PTC.Setup looks for an existing PTC License 
Server installation. If an installation is found, you are forced 
to use the existing PTC License Server directory as the 
installation directory. This ensures that you do not install 
multiple PTC License Servers on the same machine.
Installing PTC License Server 3-5 



– Disk Space—This area displays the available disk space and the 
space requirements for each component.

– License File—Specify a license file by browsing to the encrypted 
license file. You can also drag your license file into the License 
File text box. The large box under the License File text box 
displays the information in the license file.

5. Optionally, click FLEXlm Server Options to specify the following 
items:

– Directory in which you can create links.

– Server process owner (UNIX only).

– License server startup options.

– Command line arguments. This gives the administrator the 
control over the server processes. See FLEXlm End Users Guide for 
details.

– Start of the license server if the system is rebooted.

6. Click Install to start the installation of the license server. Upon 
completion, PTC.Setup starts the license server.

Exception: Triad installations require that you configure two other license 
servers.

Note
On Windows systems, the PTC License Management tools program 
is added to the Start > Programs menu. For more information, see 
Lmtools Utility (Windows Only) on page B-3.

Supplying Your License Information
You can use one of the following methods to supply the license 
information that is specific to your site or individual workstation.

• Import the license information from disk (RECOMMENDED).

• Drag your license file into the License File text box.

• Manually enter the license information using a text editor.

After you provide your license information, PTC.Setup automatically 
saves this file within the FLEXlm installation directory.

Restriction: Do not combine your PTC license file with license files of 
other software vendors on the same FLEXlm license server. Although 
FLEXlm can handle combined license files, PTC license files use a 
vendor-specific Host ID making them incompatible with license files 
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using a FLEXlm Host ID. The PTC.Setup utility reads combined vendor 
license files as invalid.

Note
If you want to manually specify your license file information, click 
Back. For detailed information, see Entering Your License File 
Information Manually on page 3-8.

For FLEXlm triad installations, edit the license file before you install each 
of the license servers. To do so, type the hostname of each of the triad 
partner. If this is not done, the license files will be different on each of the 
three triad partners, resulting in the failure of the license server startup.

Completing the FLEXlm Installation
The Installation Progress screen displays the status of installation. You 
can also do one of the following operations:

• Click Cancel to cancel the installation.

• Click Back and review information. 

• Click Next to install the next selected component.

The Installation Progress screen announces a successful installation. If 
the installation fails, a ptcsetup.log file is created in the temp 
directory. It reports all the errors during installation.

Click Exit to quit the PTC.Setup installation utility.

Repeating Steps for Triad Installations
To configure the two other license servers, repeat the aforementioned 
steps in the sections Installing PTC License Server on page 3-3.

Note
PTC and Macrovision recommend that the Triad license servers be at 
the same geographical site and the same subnet. Refer to the FLEXlm 
End Users Guide for further details.

Verifying License Server Activity
Before configuring your software, verify that PTC.Setup has started the 
FLEXlm license server by running the ptcstatus command on the 
license server machine. PTC.Setup installed the ptcstatus command in 
the /bin directory of the FLEXlm installation directory (for example, on 
Windows C:\ptc\flexlm\bin\ptcstatus). For Triad installations, 
two of the three partner machines must be configured before the 
information is displayed in the ptcstatus output.
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To run the FLEXlm server, you must have Windows administrator or 
UNIX user privileges. For additional information see Machine-Specific 
Configuration on page B-3.

Output from the ptcstatus utility displays the feature name (for example, 
PROE_38265), a user-defined name or alias if one was supplied, the 
number of licenses in use, the number of available licenses, and any 
restrictions (for example, the license is locked to a particular machine).

Entering Your License File Information Manually
If you do not have an electronic copy of your License Pack, you can enter 
your license file information manually. To do so, type your license 
information into the License File Editor directly.

Using the FLEXlm License Editor
To enter your license codes manually, follow these steps:

1. In the Define Installation Components dialog box, click  under 
License File.

2. The FLEXlm license editor dialog boxes opens and is empty. You can 
either import the file or enter each line of your license file in the 
FLEXlm license editor. From the File menu, you can:

– Import your license file from another location.

– Append the contents in the FLEXlm license editor with a file on 
your system.

– Save your license information.

– Create a copy.

Use the Open dialog box to import or append your license file if 
your license information (ASCII format) is on your system.

3. Alternatively, type each line of your license information as it appears 
in your PTC License Pack. Replace generic text where appropriate. 
Start with the line that begins after #Start: License File for 
CPUID. Format the text exactly as shown in the License Pack with 
justification indents. The text is case-sensitive.

Note
You do not have to type any lines that begin with a crosshatch (#). 
This text in your License Pack is strictly informational.
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4. If you type them in, PTC.Setup will replace the two generic strings, 
__HOSTNAME__ and __PTCD_PATH__, including the underscore 
characters with the correct value after you select File > Save from the 
FLEXlm license editor.

In your License Pack, the default server line format is as follows:

SERVER __HOSTNAME__ PTC_HOSTID=(Your CPUID) 7788

To install PTC License Server, only one vendor daemon line is needed 
per license server.

When you are finished, the FLEXlm license editor should look 
similar to the next window.

PTC.Setup verifies whether the entered information is correct. If an 
invalid license is listed, an error message appears. You cannot proceed 
until all the licenses are listed in the valid license column. For further 
information, see Appendix D, Troubleshooting Tips.
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 4
Installing and Starting

Pro/ENGINEER
This chapter explains how to install your newly purchased software. The 
procedures are for new installations only. If you are updating or 
modifying an installation, refer to Chapter 11, Updating and Modifying 
an Installation.

You may need to change some machine settings before installing a 
particular software component. This information is located in the READ 
THIS FIRST document, which is included with your software package.
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Installing Pro/ENGINEER
You install Pro/ENGINEER after you have installed PTC License Server. 
You can install your product software on a license server, a license client, 
a node-locked machine, or on any combination of these machines.

Note
Usage of uncounted, node-locked licenses does not require PTC 
License Server.

Four major steps are required for successful installation of your product 
software:

• Defining your installation components, including the installation 
directory

• Specifying the location of the license servers or license file

• Defining the command names and attaching available features

• Starting the software

Upward Compatibility
Pro/ENGINEER is upward compatible. That is, Pro/ENGINEER files 
(parts, assemblies, drawings) created in a previous release of 
Pro/ENGINEER can be retrieved and saved using Pro/ENGINEER 
Wildfire 2.0.

Defining the Installation Components
1. Insert the product software CD-ROM on your Windows operating 

system. Insert and mount the product software CD-ROM on your 
UNIX system. For step-by-step instructions, see Loading and 
Mounting the CD-ROM on UNIX on page B-8.

The PTC.Setup Welcome screen appears followed by the product 
selection screen.
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2. Click Pro/ENGINEER. The Define Installation Components screen 
appears.

At this point, you have installed FLEXlm either on the license server 
or on the license client.

Note
When you update to a new release of a PTC product, you must 
update your License Pack to match the product release.

On UNIX, the Accept License Agreement screen appears. Accept the 
JRE license agreement and click Next to proceed. The Define 
Installation Components screen then appears.
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3. Define the following installation parameters:

– Destination Folder—For new installations, keep the default 
installation directory, for example, C:\Program Files\
proeWildfire2.0, or specify the full path. PTC.Setup creates 
the specified new directory. You can also select a different 
installation directory.

For new installations, the directory that you specify must be new 
or empty.

Note
On Windows, you can have only one installation of a 
Pro/ENGINEER datecode on a machine. If you install the 
same datecode again, PTC.Setup looks for the existing 
Pro/ENGINEER datecode installation. If such an installation 
is found, you are forced to use the existing Pro/ENGINEER 
installation directory as the installation directory. This 
ensures that you do not have multiple installations of the 
same Pro/ENGINEER datecode on the same machine.

– Under Features to Install, click  before each of the 
components and provide the following information:

Product Features—Choose the components that you want to 
install by clicking  next to each of the components. Select 
one of the following commands from the list:

Install this feature—Install the component. 

Do not install this feature—Do not install the component.

Note
If a product component has subcomponents, you can install 
them by selecting install all sub-features from the list that 
appears when you click . The icon  changes to 

 to indicate that the components will be installed.

The available components are:

Pro/ENGINEER—This installs the files necessary to run the 
software for Pro/ENGINEER Wildfire 2.0.

Pro/ENGINEER Help Files—Keep this component to install the 
Pro/ENGINEER Help files in the product installation directory. 
To view context-sensitive Help, you must install these HTML 
files. If you install the Help files in the Pro/ENGINEER load 
point, you do not have to specify their location. Pro/ENGINEER 
automatically detects their location when the program is in use.
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Note
To install the PTC Help files in a common Help directory, go 
back and select PTC Help from Other Products in the 
product selection screen. Selecting PTC Help enables you to 
install Help in a directory other than the Pro/ENGINEER 
load point, for example, C:\Program Files\
ptchelpWildfire2.0. You define the common Help 
directory during the installation of Pro/ENGINEER in the 
Help Files Search Path screen.

PTC.Setup—Select this component to install PTC.Setup for 
reconfiguration of the software after the installation. This utility 
allows you to make configuration changes without running 
PTC.Setup from the CD-ROM.

Options—Select this component to install ModelCHECK, the 
required J2RE component, Mold Component Catalog, 
Pro/Plastic Advisor, Pro/NC-GPOST, VERICUT, and Distributed 
Pro/BATCH.

Note
You can install only the Distributed Pro/BATCH client by 
selecting Do not install this feature for all other components, 
including Pro/ENGINEER. Make sure to do this if you plan 
to use Distributed Pro/BATCH with a Distributed Services 
Manager. In order to use Distributed Pro/BATCH in 
standalone mode, you must install Pro/ENGINEER.

API Toolkits—Select this component to optionally install the files 
necessary to run the Application Program Interface toolkits like 
Pro/J.Link, Pro/Web.Link, and Pro/TOOLKIT. 

Interfaces—Select the various interface tools, specifically the files 
for Pro/INTERFACE for CADDS 5, Pro/INTERFACE for CATIA, 
Pro/CDT, and Pro/FEMPOST.

Platforms—Select the platforms, for example, 
sun4_solaris_64. Your machine's architecture is 
automatically selected as the default platform.

Languages—Select the required languages. English is always 
installed by default. You cannot disable this installation.

Disk Space—Consider the available disk space displayed and 
the required space to install the selected features.

4. Click Next after you have selected the components to install and the 
destination folder.

5. The Flexlm license servers screen appears. See the next page.
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Specifying the Location of the License Information
The PTC.Setup installation utility can access your license information on 
a remote license server or on a local machine. Your next task is to specify 
the locations of the license servers or license files that you want this 
installation of your product software to access.

If you attempt to access your license information from a machine without 
a valid version of FLEXlm, an error message tells you to update your 
license server.

Note
Pro/ENGINEER Wildfire 2.0 requires FLEXlm version 8.4a or 
later.

Specifying the License Server
Depending on the location of your license server, you must provide 
PTC.Setup with the location of your licensing information.

• If PTC License Server resides on the same machine on which you are 
installing the software, and you have used the default 
communications port for the license server, you do not have to 
specify the license server. PTC.Setup detects the server name and 
populates the Flexlm License Servers list box. 

• If PTC License Server resides on a different machine, you must 
specify the license server. See the sections, Obtaining a License from a 
Server or Servers, and Obtaining a Locked License from an 
Individual License File.

Note
In order to use Structural and Thermal Simulation (formerly 
Pro/MECHANICA) with Pro/ENGINEER in integrated mode, 
you must include the Structural and Thermal Simulation license 
servers in the list of servers.
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Specifying the License Client
If you are installing the software on a license client without FLEXlm 
installed, the Flexlm License Servers list box is initially blank. To enable 
this installation to obtain floating licenses from a remote server, you must 
define the servers that are distributing the licenses. See Obtaining a 
License from a Server or Servers on page 4-8. If this installation is to read 
a license file for locked licenses, you must specify the full path to and the 
name of the license file. See Obtaining a Locked License from an 
Individual License File on page 4-9.

Note
You cannot run the software without checking out a license. This 
means that Pro/ENGINEER cannot be installed without a 
license. Pro/ENGINEER Wildfire 2.0 uses FLEXlm 8.4a as its 
license server.
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Obtaining a License from a Server or Servers
To obtain a license from a server or servers:

1. Click Add in the Flexlm license servers screen (see the previous 
screen). The Specify License Server dialog box opens.

2. Click one of the server options and enter the requested information.

– Single license server—Specifies a single server for the licenses. 
Type the host name and the communications port number if it is 
different from the default. This information identifies the server, 
for example, aberdeen, from which this installation obtains its 
license codes.

– Triad license server (fault tolerant)—Specifies a Triad 
configuration of three Triad partners. As long as two or more 
partners are running, the licenses are served. If two or more 
partners are not functioning, the server stops serving the licenses.

Define all three license servers. Each Triad partner server must 
have the same license file. 

Note
The order of the server list (Triad Partner 1, Triad Partner 2, 
Triad Partner 3) must be the same on all the three license 
servers.
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PTC recommends that the Triad license servers be at the same 
site. For further information on redundant license servers, see the 
FLEXlm End Users Guide.

Note
Do not specify the host name of the client nodes. Specify only 
the license server that controls usage of the licenses. You can 
use the Specify License Server dialog box to configure the 
clients to access multiple servers or license files across your 
network.

– Locked license file (no server running)—For locked license files, 
see the section, Obtaining a Locked License from an Individual 
License File on page 4-9.

3. Click OK to add the server and communications port information to 
the Flexlm License Servers list box. For example, 7788@aberdeen. 

4. Click Next to open the Windows Preferences screen on Windows 
and the Optional Configuration Steps screen on UNIX.

Obtaining a Locked License from an Individual License File
To obtain a locked license from an individual license file on your local 
machine or on the network:

1. Click Add in the Flexlm License Servers screen. The Specify License 
Server dialog box opens.

2. Click Locked license file (no server running).

3. Perform one of the following actions:

– Specify the full path to your license file on your local or 
NFS-mounted disk, for example, C:\Program 
Files\flex\license.dat.

– Click the folder icon, navigate the folder hierarchy, and select the 
correct license file.

4. Click OK to add the license file path information to the Flexlm 
License Servers list. The list when expanded displays the license 
features available on the selected server.

5. Click Next. The Windows Preferences screen appears if you are 
working on Windows. On UNIX, the Optional Configuration Steps 
screen appears. 
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Configuring a Windows Installation
If you are installing Pro/ENGINEER on Windows, you can choose to do 
the following optional tasks:

• Add additional license configurations.

• Configure the installation while working with other products.

• Configure Pro/ENGINEER as an Object Linking and Embedding 
(OLE) server.

• Create Windows shortcuts to start Pro/ENGINEER.

• Configure Pro/ENGINEER distributed services.

• Configure your Remote Batch Server.

• Specify the full path to your Help installation directory. (Specifying 
the load point and installing the Help files are necessary steps to 
enable the users of clients to view Help.)

After you complete each optional configuration, click Next to proceed.

Adding License Configurations
Click the Additional license configurations check box to create a license 
configuration. Perform the following steps:

1. Add the additional configurations by clicking Add in the License 
configurations dialog box.

The Select Licenses dialog box opens. A license configuration called 
Pro/ENGINEER is always created by default. 

Note
Configuration Description is a user-defined label name 
that is displayed on Pro/ENGINEER startup if you have defined 
more than one license configuration. Configuration Name is a 
file name (*.psf) that stores the license configuration 
information. You can change this file name if required. Use 
alphanumeric characters to define the configuration name. 
Configuration Description can contain spaces and other 
characters that are not allowed in the Configuration Name.

The list of all available licenses is displayed under the Available 
Licenses section. These licenses could be of type license to run, 
startup extensions, or floating options.
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2. Specify the licenses by highlighting the required license and moving 
it to the Selected Licenses column. The Select Licenses section 
displays the set of all licenses to run and the startup extensions and 
floating licenses.

Enabling Interoperability with Other Products
Click Configure Other Product Interoperability to enable 
interoperability with other products.

• Pro/INTRALINK integration (optional)—Specify a path only if you 
run Pro/INTRALINK on this license client along with 
Pro/ENGINEER. You can also specify a Pro/INTRALINK startup 
command. If you specify an existing and valid Pro/INTRALINK 
directory, you can select a Pro/INTRALINK startup command from 
the list of available commands. If you have not installed the 
Pro/INTRALINK client, you can specify the required 
Pro/INTRALINK installation directory and the required 
Pro/INTRALINK startup command.

• Locate Other Installation Locations (optional)—Specify paths only if 
you run PTC Application Manager and Structural and Thermal 
Simulation on this license client in conjunction with Pro/ENGINEER. 
If none of these optional modules are attached to the command you 
assigned to start Pro/ENGINEER, you can leave the lines blank or 
configure them later by rerunning PTC.Setup. If 
Pro/PHOTORENDER has been purchased as an optional module, 
enter the full path to the Graphic Library directory.

• If you plan to make Pro/ENGINEER a PTC Object Linking and 
Embedding (OLE) server and you want to use the startup command 
with the PTC OLE server, click Next to open the PTC OLE Server 
screen.

Note
You can install both Pro/ENGINEER and Mechanica in the same 
installation session. In such a case, if you have already installed 
Pro/ENGINEER, the Mechanica load point value is automatically 
used in the Pro/ENGINEER load point directory during the 
installation of Mechanica. If you have already installed Mechanica, 
the Pro/ENGINEER load point value is automatically used in the 
Mechanica load point directory during the installation of 
Pro/ENGINEER. You need not specify a separate directory for 
Mechanica or Pro/ENGINEER installation.

After you specify your optional input, click Install. 

The steps, which are optional, vary for Windows and UNIX systems.
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Configuring the PTC OLE Settings
Click OLE settings on the Optional Configuration Steps screen to 
configure Pro/ENGINEER as an OLE server. This allows the user of the 
client application to import Pro/ENGINEER files (parts, assemblies, and 
drawings) into Microsoft documents (Word, Excel, and Power Point). 
This does not configure Pro/ENGINEER as an OLE container. That is, 
you cannot import Microsoft files into Pro/ENGINEER by performing 
this step. In the PTC OLE Server screen, you can:

• Specify the command used to start Pro/ENGINEER.

• Specify the default startup directory for Pro/ENGINEER. Typically, 
this is the Pro/ENGINEER working directory.

• Keep the Pro/ENGINEER language default unless you plan to use 
another language.

• Specify the startup directory of the PTC OLE Server. The Microsoft 
application program (that is, a PTC OLE container) starts searching 
for PTC objects (for example, Pro/ENGINEER parts) in this directory. 

• Keep the PTC OLE Server language default unless you plan to use 
another language.

Creating Windows Shortcuts
On Windows, you can configure the Windows shortcut preferences and 
path settings for Pro/ENGINEER. 
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You can set the following shortcut preferences:

• Shortcut Location(s)—You can start Pro/ENGINEER from the 
desktop, the Start menu, the Start > Programs menu, or any 
combination of these three options. 

• Program Folder—If you select Program folder as the shortcut 
location, specify the name of the folder and option in the Programs 
menu. 

• Startup Directory—Specify the name of the Pro/ENGINEER startup 
directory. 

You can set the following Windows environment preferences:

• Modify system environment for all users—Sets the system PATH 
variable for all users on the system.
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Note
You must have the administrator privileges to set the system 
environment variable for all users.

• Modify current user’s environment only—Sets the user’s PATH 
variable for the current user on the system.

Configuring Pro/ENGINEER Distributed Services
Click Pro/ENGINEER distributed services configuration on the 
Optional Configuration Steps screen to configure your Pro/ENGINEER 
workstation to participate in distributed processing sessions.
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Supply the following information to configure your Pro/ENGINEER 
workstation to participate in distributed processing sessions:

• The Pro/ENGINEER startup command.

• The directory path to use as a temporary working area for the 
Distributed Computing Server. The temporary files are created here 
during a distributed computing session. You can also browse to the 
required location.

Configuring Your Remote Batch Settings
Click Remote batch settings on the Optional Configuration Steps screen 
to configure the Pro/ENGINEER installation for use as a Remote 
Toolpath Computation Server. This enables remote batch jobs to be run on 
this machine. You start the Remote Batch Server after the installation 
process by running the rbm_startup script.

Supply the following information to configure the rbm_startup script:

• The Pro/ENGINEER startup command that is used to run remote 
batch jobs (for example, proe_rb).

• The maximum number of Pro/ENGINEER sessions to be started on 
this machine for processing jobs.

• The frequency of communication (in seconds) between 
Pro/ENGINEER and the Remote Batch Server.

• The RPC communications port number for communication with 
machines that are using this installation as a Remote Batch server.

• The directory in which Pro/ENGINEER runs when processing batch 
jobs.

Specifying the Location of Your Help Files
Note
Identifying the location of your Help files is not necessary if you 
installed the Pro/ENGINEER Help files within the product 
installation directory.

By selecting PTC Help under Other Products in the PTC.Setup product 
selection screen, you can install the Pro/ENGINEER help files in a 
location other than the Pro/ENGINEER installation directory. 

Note
This procedure identifies the location of the HTML files. It does not 
install the Help files. In order for the Help and the online reference 
documentation to be visible from a Web browser, the Help search 
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paths to the Help installation directory must be supplied here. See 
Chapter 8, Installing PTC Help for details.

1. Click Help files search path on the Optional Configuration Steps 
screen to specify the directory that contains or will contain your 
product’s Help files. 

2. In the Help Files Search Path screen, specify a common master Help 
directory, such as C:\Program Files\ptchelpWildfire2.0.

3. Add the Help installation directory by clicking Add. 

4. Specify the URL to the Help installation directory on your Web 
server, for example, http://<servername>/<path>
/ptchelpWildfire2.0. Or, browse to or enter the full path to the 
load point of a local machine that contains or will contain the product 
Help files, for example, C:\Program Files\
ptchelpWildfire2.0.

5. Click OK and Install. You can Edit and Delete this location.

Note
Context-sensitive Help for Pro/ENGINEER products is available 
on the product CD-ROM.

Configuring a UNIX Installation
Optional configuration steps follow for your installation of 
Pro/ENGINEER on UNIX systems. You can accept or clear the following 
items:

• Add additional license configurations. 

• Configure the installation while working with other products.

• Create a symbolic link to the commands that start your software.

• Set the Design Conferencing Server.

• Configure Pro/ENGINEER distributed services.

• Configure your Remote Batch Server.

• Specify the full path to your Help installation directory (specifying 
the load point and installing the Help files are necessary steps to 
enable clients to view Help).

After you complete each optional configuration, click Next to proceed.
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Creating Links
Click Create links to product startup commands on the Optional 
Configuration Steps screen to create a link from the /bin directory in 
your installation directory to another directory on your UNIX system. (If 
this other directory is in your path environment setting, then simply 
entering the command name starts Pro/ENGINEER.) 

To create a link, use the Startup Command Links screen to type the full 
path or browse to the directory in which you want the link created.

Setting Up the Design Conferencing Server
Click Design Conferencing Server settings on the Optional 
Configuration Steps screen to specify the host name for the Conference 
Server.
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The Conference Server can run on a Windows system only. Thus, on an 
UNIX system, you need to connect to the Conference Server running on a 
Windows system. You can do this by specifying the host name of the 
Conference Server. PTC.Setup validates the host name you specify. If the 
validation fails, the following error message appears.
4-18 Installation and Administration Guide



You can continue the installation process even if you do not specify a 
valid host name. For information on installing the Conference server on a 
Windows system see Chapter 5, Installing Collaboration Tools (Windows 
Only).

Completing the Pro/ENGINEER Installation
After you have configured the installation, do one of the following 
operations:

• Click Back and review information. 

• Click Install to begin installation. The Installation Progress window 
displays the status of the installation.

• Click Next to install the next selected component.

• Click Exit to exit PTC.Setup.

During installation, you can click Cancel at any time to stop the 
installation. PTC.Setup copies files and sets file permissions. During 
copying, you may be prompted to insert another CD-ROM. Either insert 
the CD-ROM or provide the path to the CD-ROM. If the installation fails 
due to some reason, a ptcsetup.log file is created in the temp 
directory that gives a report of all the errors that occurred during 
installation.

For procedures, see Specifying the Location of the License Information, 
and Configuring the PTC OLE Settings discussed earlier in this chapter.

Configuring Pro/ENGINEER Startup (Windows 
Only)

When you configure a Pro/ENGINEER startup on Windows, an 
executable file named proe.exe and one or more configuration files 
(.psf) are created for each startup configuration. On Windows, the 
configuration file contains a section where you can specify and set 
user-defined environment variables. This user-defined information is 
preserved during reconfiguration and update installations of 
Pro/ENGINEER. A configuration file is created when you complete the 
Pro/ENGINEER installation. 

You can run <loadpoint>\bin\proe.exe to start the screen that 
displays a list of the available startup configurations. The screen does not 
appear if there is only one.psf file available in the bin directory. 

The configuration file is created in the <loadpoint>\bin directory. 
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Note
The configuration file must exist only in the <loadpoint>\bin 
directory.

The startup command is a combination of the startup executable and the 
configuration file. For example,

proe.exe <filename>.psf

where <filename> is the name of the configuration file.

Following is a sample configuration file for Windows. The text is the 
default information that is used when you start Pro/ENGINEER. The 
bold text following the // USER - PSF section is considered user-defined 
information. This user-defined information is used when starting 
Pro/ENGINEER.
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Note
Modify only the last text line of this sample configuration file.

You can set the value of an environment variable or specify the invocation 
of a third-party application under the // USER - PSF section of the 
configuration file. 

In the case of UNIX, you cannot edit the.psf files. 

Specifying Environmental Variables
To specify the value of an environmental variable in the configuration file:

• Use the ENV or RUN entry to specify the value of an environment 
variable or run an external application.

// PTC - PSF file: proe

//

ENV=PATH+=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%\deflib

ENV=PATH+=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%\lib

ENV=PRO_COMM_MSG_EXE=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%\

OBJ\pro_comm_msg.exe

ENV=CDRS_DATA=%PRO_DIRECTORY%

ENV=PRO_IMAGE_CONVERTER=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%\obj

\convert_image.exe

ENV=PRO_PHOTORENDER=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%\obj\PhotoRender.exe

ENV=GALAXYHOME=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%

ENV=SPG_DIRECTORY=%PRO_DIRECTORY%

ENV=PROTABLE_DIRECTORY=%PRO_DIRECTORY%\protable

ENV=PROTAB=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%\OBJ\protab.exe

ENV=CLHOME=%PRO_DIRECTORY%\text\pcldata

ENV=CV_ENV_HOME=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%\CV102

ENV=LM_LICENSE_FILE=7788@static

ENV=PROE_FEATURE_NAME=PROE_INHOUSE

RUN=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%\nms\nmsd.exe -timeout 300

RUN=%PRO_DIRECTORY%%PRO_MACHINE_TYPE%obj\xtop.exe

// USER - PSF

// Add User specific environment or run applications below here

ENV=DPS_DEBUG=10
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• Use the equal sign (=) following the text ENV to change the existing 
value of the variable.

• Use the plus and equal to signs (+=) to prefix a value to an existing 
value of the variable.

• Use the minus and equal to signs (-=) to suffix a value to an existing 
value of the variable.

• Use the RUN entry to run an external command on startup.

Using the Configuration File When Running Pro/ENGINEER
The configuration file is used as an argument when you run the 
proe.exe executable to start Pro/ENGINEER.

Note
When you run Pro/ENGINEER from the command line, specify the 
configuration file as the first argument followed by any other 
argument, such as, a trail file.

If you do not specify the configuration file when running 
Pro/ENGINEER, a dialog box opens with a list of available configuration 
files. Select one of these configuration files. 

If you run Pro/ENGINEER without creating a configuration file, the 
following error message appears:

If you create only one configuration file, Pro/ENGINEER uses this 
configuration file by default.

Generating a Debug Log File
You can run the proe.exe executable in the debug mode by setting the 
value of the environment variable APPL_STARTUP_LOG to true. On 
Windows a debug output log file named applstarter.log is created 
in the C:\ drive. On UNIX, the debug output log file, 
applstarter.log, is created in the \tmp directory. You can also use the 
APS_LOG environment variable to set an alternative log file path. 
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The debug output log file contains the environment variables that you 
have set.

Starting Pro/ENGINEER
After your license management and product software has been installed, 
start Pro/ENGINEER. 

Windows
Run Pro/ENGINEER on Windows using the shortcut defined on your 
desktop or from the Start menu click Programs > Ptc > Pro ENGINEER > 
proewildfire2.0.

UNIX
From a UNIX prompt use <loadpoint>/bin/proe to start 
Pro/ENGINEER or navigate to the Pro/ENGINEER installation directory 
and run the command that you defined during the installation process. 
For example, /opt/ptc/proeWildfire2.0.

Directory Permissions to Start Pro/ENGINEER
After you install Pro/ENGINEER, if you start it from a directory without 
write permissions, the following dialog box opens:

To continue, specify another directory with write permissions. The 
working directory remains the same, but the trail files are stored in the 
new working directory that you have specified.

Note
You cannot start Pro/ENGINEER from a directory without write 
permissions unless you specify an alternative directory to store the 
trail files.
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Generating a Traceback Log File
In the event of a premature exit, Pro/ENGINEER can output a stack trace 
of your last operations if you set the auto_traceback configuration 
option to yes. The default value is no. By default, this information is 
stored in the traceback.log file in the startup directory. The following 
dialog box opens to indicate the premature exit of Pro/ENGINEER:

The traceback.log file can sometimes be useful to Technical Support 
to resolve the premature exit issue. If you click Cancel, Pro/ENGINEER 
exits without creating the traceback.log file. If you click OK, the 
following dialog box opens:

Pro/ENGINEER exits after creating the traceback.log file in the 
current working directory.

Note
If you start Pro/ENGINEER from a directory without write 
permissions, the traceback.log file is stored in the directory that 
you have specified using the Choose startup directory dialog box.
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Removing Pro/ENGINEER (Windows Only)
You can remove your Pro/ENGINEER software application through the 
Control Panel. This procedure is for Windows systems only.

1. From the Start menu, click Settings > Control Panel.

2. Double-click the Add/Remove Programs icon. The Add/Remove 
Programs dialog box opens.

3. In the program application list, click the specific release of 
Pro/ENGINEER you want to remove.

4. Click Remove. The PTC Uninstall dialog box opens.

5. Click Uninstall or Cancel to escape. You are presented with a series 
of confirmation statements asking permission to remove files. 

6. Click Uninstall to proceed. Upon completion, Pro/ENGINEER is 
removed.
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 5
Installing Collaboration
Tools (Windows Only)
This chapter explains how to install Collaboration Tools. Collaboration 
Tools include the PTC Conference Server and the PTC Conference Center, 
and the Groove software. This chapter also explains how to start the PTC 
Conference Server and PTC Conference Center.

Topic Page

Installing Collaboration Tools 5 - 2
Completing the Collaboration Tools Installation 5 - 5
Starting PTC Conference Server 5 - 6
Design Conferencing Licensing Scheme 5 - 7
Removing Collaboration Tools 5 - 8
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Installing Collaboration Tools
To install Collaboration Tools, you must have administrative privileges. 
Successful installation of your software involves the following steps:

• Defining your installation components, including the installation 
directory

• Performing optional configuration steps

• Starting the software

Note
On 32-bit Windows systems, install Collaboration Tools on your 
computer directly using the PTC.Setup utility. On UNIX, Linux, and 
64-bit Windows systems, select a remote 32-bit Windows system to 
install Collaboration Tools. In such a case, you are automatically 
connected to the PTC Conference Server on the remote Windows 
system as soon as you start the PTC Conference Center.

Defining the Installation Components
To install Collaboration Tools, follow these steps:

1. Start PTC.Setup using the steps in Starting PTC.Setup on page 1-5. 
During installation, you can click Cancel at any time to stop the 
installation. PTC.Setup copies files and sets file permissions.

2. Select Collaboration Tools from the PTC.Setup product selection 
screen. The Define Installation Components screen appears.

Note
When you perform an update or install a new release of a PTC 
product, you must update your license information.
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3. Define the following parameters:

– Destination Folder—For new installations, keep the default 
installation directory, for example, C:\Program Files\PTC 
Collaboration Tools, or specify the full path. PTC.Setup 
creates the specified new directory. You can also select a different 
installation directory.

Note
For 32-bit Windows systems, install Collaboration Tools in a 
folder where Pro/ENGINEER is not installed.

– Under Features to Install, click  before each of the 
components and provide the following information:
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Product Features—Choose the components that you want to 
install by clicking  next to each component. Select one of 
the following commands from the list:

Install this feature—Install the component. 

Do not install this feature—Do not install the component.

Note
If a component has subcomponents, you can install them by 
selecting install all sub-features from the list that appears 
when you click . The icon  changes to  to 
indicate that the components will be installed.

The available component is Collaboration Tools. The disk space 
required for the product is displayed. For new installations, the 
directory must be new or empty.

Platforms—Select the platform for the installation. Your 
machine's architecture is automatically selected as the default 
platform.

Languages—Select the required languages.

4. Click Next. The Windows Preferences screen appears.

Performing Optional Configuration Steps
Setting shortcut preferences and path settings for Collaboration Tools are 
optional configuration steps.

1. Click Next in the Define Installation Components screen to open the 
Windows Preferences screen. 

2. Set the following shortcut preferences:

– Shortcut Location(s)—You can start Collaboration Tools from the 
Desktop, the Start menu, the Program menu, or any combination 
of these three options. 

– Program Folder—If you select Program Folder as the shortcut 
location, select the name of the folder from the Program Folder 
list.

– Startup Directory—Specify the name of the Collaboration Tools 
startup directory.
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3. Set the following Windows environment preferences:

– Modify system environment for all users—Sets the system 
PATH variable for all users on the system.

– Modify current user’s environment only—Sets the user’s PATH 
variable for the current user on the system.

4. Click Install. The Installation Progress screen appears.

Completing the Collaboration Tools Installation
When you see the Installation Progress screen, you can also do one of the 
following operations:

• Click Cancel to stop the installation.

• Click Back to review information. 

• Click Exit to quit the PTC.Setup installation utility.

During installation of Collaboration Tools, you are prompted to install the 
Groove software. See the next section, Installing Groove.

Installing Groove
During the installation process of the Conference Server, a Groove Wizard 
appears. The Groove software enables the peer-to-peer connectivity and 
the security functions of Collaboration Tools.

1. Click Next to continue the installation of Groove software.

2. Click Next to create the default destination folder. Or, click Browse to 
select a different destination folder. 

3. Click Next to create the user data folder. Or, click Browse to select a 
different folder. 

4. Click Next to create the system data folder. Or, click Browse to select 
a different folder. The Installation Options screen appears.

5. Choose one or more of the following installation options:

– Install Groove for All Users—Allows all users to run the Groove 
software.

– Add Groove to Desktop—Creates a shortcut for Groove software 
on your desktop.

6. Click Next.

7. Specify the Program folders. Click Next.
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8. The Check Setup Information screen appears with the installation 
information for the Groove software. Click Back to go to the previous 
windows and change the installation settings. Click Next.

The Setup Status screen appears and displays the status of the 
installation.

9. Click Finish on the Groove Setup screen to complete the installation 
of Groove software.

10. After you have configured the installation, do one of the following in 
the PTC.Setup installation utility:

– Click Back and to review the information that you have specified 
earlier. 

– Click Install to begin installation. The Installation Progress 
window displays the status of the installation. Click Cancel to 
stop the installation.

– Click Next to install the next selected component.

– Click Exit to quit PTC.Setup.

Note
PTC recommends that you use the version of Groove 
software supplied with the PTC software. PTC does not 
support the updating of the Groove software outside the 
PTC.Setup installation utility. 

If the installation fails, a ptcsetup.log file is created in the temp 
directory. It reports all the errors during installation.

Starting PTC Conference Server
The PTC Conference Server starts when you start the PTC Conference 
Center in one of the following ways:

• Start the standalone PTC Design Conferencing application using the 
shortcut on your Windows desktop. From the Windows Start menu, 
click PTC > Collaboration Tools > Conference Center. 

• From a Pro/ENGINEER session, click Applications > Conference. 

When you start the PTC Conference Center, it looks for a PTC Conference 
Server. If the PTC Conference Server does not start, do one of the 
following:

• On UNIX, select a remote server.

• On Windows, start the server locally.
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Design Conferencing Licensing Scheme
A license extension, called Collaboration_Extension (DCX), is 
bundled with the Pro/ENGINEER license. 

A Design Conferencing Participant (DCP) License is also available, which 
allows you to participate in a shared session without using the 
collaboration license extension.

You can configure a Pro/ENGINEER startup command to include the 
collaboration license extension. With this license, you have full access to 
the PTC Conference Center, shared spaces within a Pro/ENGINEER 
session, and the ability to initiate shared Pro/ENGINEER sessions. 

Within a conference session, the collaboration extension license is verified 
when you take one of the following actions:

• Start a Pro/ENGINEER session.

• Browse through the shared spaces.

To release the collaboration extension license, you must close the 
Pro/ENGINEER session or exit the conference. 

Design Conferencing Participant License
The Design Conferencing Participant (DCP) license allows you to do the 
following:

• Use the PTC Conference Center to access the basic features of Design 
Conferencing.

• Join and participate in a Pro/ENGINEER shared session that is 
initiated by a participant with a DCX license.

Restrictions for Design Conferencing Participants follow:

• You cannot initiate a shared session of Pro/ENGINEER but can join a 
session of an initiator with the DCX license.

• You can participate in a shared session only when the DCX license of 
the initiator is added to the conference license pool.

• You cannot start Pro/ENGINEER outside the shared session that you 
have joined. In such a case, an error message is displayed.

• The Pro/ENGINEER shared session ends with a warning message 
when all the participants with DCX licenses have left the shared 
session.
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Removing Collaboration Tools
You can remove Collaboration Tools through the Control Panel. This 
procedure is for Windows systems only. 

1. Exit all the applications running on your system and check if you are 
still running the Conference Server.

2. From the Start menu, click Settings > Control Panel.

3. Double-click the Add/Remove Programs icon. The Add/Remove 
Programs dialog box opens.

4. In the program application list, click the release of Collaboration 
Tools you want to remove.

5. Click Remove. The PTC Uninstall dialog box opens.

6. Click Uninstall or Cancel. You are presented with a series of 
confirmation statements asking permission to remove files. 

7. Click Uninstall to proceed. The Collaboration Tools are removed.

Uninstalling Groove
When you uninstall the Collaboration Tools, the Groove uninstaller is 
also started. 

Note
Do not uninstall the Groove software by selecting the Groove 
uninstall command on the Add/Remove programs window. It must 
be uninstalled along with the Collaboration Tools.

When the Groove software is uninstalled correctly, the account 
information along with shared spaces is preserved.
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Installing Structural and

Thermal Simulation
This chapter explains how to install the Structural and Thermal 
Simulation product powered by Mechanica. The procedures are for new 
installations only. You may need to change some machine settings before 
installing a particular software component. This information is located in 
the READ THIS FIRST document, which is included with your software 
package. For information on supported platforms and configurations, 
refer to www.ptc.com/partners/hardware/current/support.htm.
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Installing Structural and Thermal Simulation
To install Structural and Thermal Simulation (Mechanica), you need 
licensing information from PTC. If you plan to run the software in the 
integrated mode, it is assumed that you have already obtained licensing 
information while installing Pro/ENGINEER. If you plan to run it 
independently, see Chapter 3, Installing PTC License Server, to learn how 
to install PTC License Server.

You can install your product software on a license server, a license client, 
a node-locked machine, or on any combination of these machines.

Note
Usage of uncounted node-locked licenses does not require PTC 
License Server.

Following are the major steps required for successful installation of your 
software:

• Defining your installation components, including the installation 
directory

Note
You can install both Pro/ENGINEER and Mechanica in the same 
installation session. In such a case, if you have already installed 
Pro/ENGINEER, the Mechanica load point value is 
automatically populated in the Pro/ENGINEER load point 
directory during the installation of Mechanica. You need not 
specify a separate directory for Mechanica installation.

• Specifying the location of the license server or servers or license file

• Starting the software

Note
If you use Structural and Thermal Simulation in the integrated 
mode, you must configure the Pro/ENGINEER command by 
specifying the respective Mechanica directory path. If you have 
not defined the directory path in the Product Interoperability 
Configuration Screen while installing Pro/ENGINEER, you can 
specify it now by rerunning the PTC.Setup installation utility. See 
Enabling Interoperability with Other Products on page 4-11 for 
further details.
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Defining the Installation Components
1. Start PTC.Setup using the steps outlined in Starting PTC.Setup on 

page 1-5. The PTC.Setup product selection screen appears with a list 
of products.

During installation, you can click Cancel at any time to stop the 
installation. PTC.Setup copies files and sets file permissions.

2. Click Structural and Thermal Simulation. The Define Installation 
Components screen appears.
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3. Specify the following parameters:

– Destination Folder—For new installations, keep the default 
installation directory (for example, C:\Program 
Files\mechWildfire2.0) or specify the full path. PTC.Setup 
creates the specified directory. You can also select a different 
installation directory. For new installations, the directory that you 
specify must be new or empty.

– Under Features to Install, click  before each of the 
components and provide the following information:

Product Features—Define the components that you want to 
install by clicking  next to each component. Select one of 
the following commands from the list:

Install this feature—Install the component. 

Do not install this feature—Do not install the component.

Note
If a product component has subcomponents, you can install 
them by selecting install all sub-features from the list that 
appears when you click . The icon  changes to 

 to indicate that the components will be installed.

Select the following Structural and Thermal Simulation 
components that you want to install:

Mechanica

PTC.Setup

Mechanica Help Files

Verification Models

The Mechanica, PTC.Setup, and Mechanica Help Files 
components are selected by default. When you select a 
component, the list of subcomponents appear along with the 
required disk space. Some products may not have 
subcomponents. 

Platforms—Select the platform for the installation. Your 
machine's architecture is automatically selected as the default 
platform.

Languages—Select the required languages.

4. Click Next after you have selected the components. The Flexlm 
license servers screen appears.
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Specifying the Location of the License Server or File
The PTC.Setup installation utility can access your license information on 
a remote license server or on a local machine. Your next task is to specify 
the locations of the license servers or license files that you want this 
installation of your product software to access.

If you access your license information from a machine without a valid 
version of PTC License Server, an error message tells you to update the 
license server. Refer to the READ THIS FIRST document for the latest 
information about the PTC License Server.

Specifying the License Server
Depending on the location of PTC License Server, provide PTC.Setup 
with the location of your licensing information.

• If PTC License Server resides on the same machine on which you are 
installing the software, and you have used the default 
communications port for the license server, you do not have to 
specify the license server. PTC.Setup detects the server name and 
populates the Flexlm License Servers list box of the following screen. 

• If PTC License Server resides on a different machine, you must 
specify the license server. See the sections, Obtaining a License from a 
Server or Servers on page 6-7, and Obtaining a Locked License from 
an Individual License File on page 6-9.
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If PTC License Server resides on a different machine, you must specify 
where this installation can obtain its licensing information. See the 
sections Obtaining a License from a Server or Servers and Obtaining a 
Locked License from an Individual License File.

In order to use Structural and Thermal Simulation in integrated mode 
with Pro/ENGINEER, you must include the Pro/ENGINEER license 
servers in the list of servers. 

Specifying the License Client
If you are installing the software on a license client without PTC License 
Server installed, the Flexlm License Servers section is initially blank. To 
enable this installation to obtain floating licenses from a remote server, 
you must define the servers that are distributing the licenses. 
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See Obtaining a License from a Server or Servers on page 6-7. If this 
installation is to read a license file for locked licenses, you must specify 
the full path to and the name of the license file. See Obtaining a Locked 
License from an Individual License File on page 6-9.

Note
Structural and Thermal Simulation cannot be installed without a 
license. It uses FLEXlm as its license server.

Obtaining a License from a Server or Servers
To obtain a license from a server or servers:

1. Click Add in the Flexlm License Servers screen. The Specify License 
Server dialog box opens.
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2. Click one of the server options and enter the requested information.

– Single license server—Specify a single server for the licenses. 
Enter the host name and the communications port number if it is 
different from the default. This information identifies the server, 
for example, aberdeen, from which this installation obtains its 
license codes.

– Triad license server (fault tolerant)—Specify a Triad 
configuration of three Triad partners. As long as two or more 
partners are running, the licenses are served. If two or more Triad 
partners are not functioning, the server stops serving the licenses.

Define all three license servers. Each Triad license server must 
have the same license file. 

Note
The order of the server list (Triad Partner 1, Triad Partner 2, 
Triad Partner 3) must be the same on all the three license 
servers.

PTC recommends that the Triad license servers be at the same 
site. For further information on redundant license servers, see the 
FLEXlm End Users Guide.

Note
Do not specify the host name of the client nodes. Specify only 
the license server that controls usage of the licenses. You can 
use the Specify License Server dialog box to configure the 
clients to access multiple servers or license files across your 
network.

– Locked license file (no server running)—For locked license files, 
see the section, Obtaining a Locked License from an Individual 
License File on page 6-9.

3. Click OK to add the server and communications port information to 
the Flexlm License Servers section. For example, 7788@aberdeen.

4. Click Next. The Optional Configuration Steps screen appears. 
Further steps are optional and vary for Windows and UNIX systems.

Note
On Windows, you can configure the Windows shortcut 
preferences and path settings for Structural and Thermal 
Simulation. 
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Obtaining a Locked License from an Individual License File
To obtain a locked license from an individual license file on your local 
machine or on the network:

1. Click Add in the Flexlm license servers dialog box. The Specify 
License Server dialog box opens.

2. Select the Locked license file (no server running) option (see 
previous dialog box).

3. Perform one of the following actions:

– Specify the full path to your license file on your local or 
NFS-mounted disk, for example, C:\Program 
Files\flex2001\license.dat.

– Click the folder icon, navigate the folder hierarchy, and select the 
correct license file.

4. Click OK to add the license file path information to the Flexlm 
License Server section of the Flexlm license servers screen.

5. Click Next. The Optional Configuration Steps screen appears on 
UNIX and the Windows Preferences screen appears on Windows. 
Further steps are optional and vary for Windows and UNIX systems.

Configuring a Windows Installation
The following input is optional when you configure your installation on 
Windows systems. You can:

• Specify additional license configuration.

• Create Windows shortcuts to start Structural and Thermal 
Simulation.

• Specify the full path to your Help installation directory (specifying 
the load point and installing the Help files are necessary steps to 
enable the users of clients to view Help). See the next section for 
details.

• Specify the executable file for the Web browser to display Help if 
Internet Explorer does not start.
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Specifying the Location of Your Help Files
Note
Identifying the location of your Help files is not necessary if you 
installed the Mechanica Help files within the product installation 
directory.

By choosing PTC Help under Other Products in the PTC.Setup product 
selection screen, you can install the Mechanica Help files in a location 
other than the Mechanica installation directory. 

Note
This procedure identifies the location of the HTML files. It does not 
install the Help files. In order for the Help and the online reference 
documentation to be visible from a Web browser, the Help search 
paths to the Help installation directory must be supplied here. See 
Chapter 8, Installing PTC Help for details.

1. Click Help files search path on the Optional Configuration Steps 
screen. In the Help Files Search Path dialog box, specify the directory 
that contains or will contain your product’s Help files. You can 
specify a common master Help directory, such as C:\Program 
Files\ptchelpWildfire2.0. 

2. Add the Help installation directory by clicking Add. 

3. Type the URL to the Help installation directory on your Web server, 
for example, http://<servername>/<path>/
ptchelpWildfire2.0. Or, browse to or enter the full path to the 
load point of a local machine that contains or will contain the product 
Help files (for example, C:\Program Files\
ptchelpWildfire2.0).

4. Click OK and Install. You can Edit or Delete this location.

Note
Context-sensitive Help for Mechanica products is available on 
the product CD-ROM.

Configuring a UNIX Installation
The following input is optional when you configure your installation on 
UNIX systems. You can:

• Create a symbolic link to the commands that start your software.

• Specify the full path to the PTC Application Manager.
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• Specify the full path to your Help installation directory (specifying 
the load point and installing the Help files are necessary steps to 
enable clients to view Help). See Specifying the Location of Your Help 
Files on page 6-10.

• Specify any additional license configuration.

• Specify the location of your Web browser executable file that you 
want to use to display Help.

For step-by-step instructions, see Configuring a UNIX Installation on 
page 4-16.

Completing the Installation
The Installation Progress screen displays the status of installation. You 
can also do one of the following operations:

• Click Cancel to cancel the installation.

• Click Back and review information. 

• Click Next to install the next selected component.

The Installation Progress screen announces a successful installation. If 
the installation fails, a ptcsetup.log file is created in the temp 
directory. It reports all the errors during installation.

Click Exit to quit the PTC.Setup installation utility.

Starting Structural and Thermal Simulation
After your license management and software has been installed, start 
Structural and Thermal Simulation. The method that you use to start 
Mechanica depends on the platform and the operating mode.

Windows 
To work in the integrated mode, double-click the icon that starts 
Pro/ENGINEER. After Pro/ENGINEER opens, activate a part or an 
assembly and click Applications > Mechanica. To work in the 
independent mode, use the shortcut defined in the program group by 
double-clicking on the associated icon. The shortcuts are defined as 
mstruct for Structure and mtherm for Thermal.
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UNIX
To work in the integrated mode, start Pro/ENGINEER by entering the 
command name that you defined during the installation process. After 
Pro/ENGINEER opens, activate a part or an assembly and click 
Applications > Mechanica. To work in the independent mode, from a 
UNIX prompt, type the appropriate command name. Use the commands 
mstruct for Structure and mtherm for Thermal. 

Removing Structural and Thermal Simulation 
(Windows Only)

You can remove your Structural and Thermal Simulation software 
through the Control Panel on Windows systems. To do so, follow these 
steps:

1. From the Start menu, click Settings > Control Panel.

2. Double-click the Add/Remove Programs icon. The Add/Remove 
Programs dialog box opens.

3. In the program application list, highlight the specific release of 
Structural and Thermal Simulation that you want to remove.

4. Click Remove. You see the PTC Uninstall dialog box.

5. Click Uninstall or Cancel to escape. You are presented with a series 
of confirmation statements asking permission to remove files. 

6. Click Uninstall to proceed. Structural and Thermal Simulation is 
removed.
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Installing PTC Application

Manager (UNIX Only)
This chapter explains how to install PTC Application Manager and 
application libraries of models and textures on a UNIX system. The PTC 
Application Manager utility installs a toolbar for easy access to your 
desktop applications when using Pro/ENGINEER.
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Installing PTC Application Manager
PTC Application Manager is a toolbar utility on your UNIX system. 
Similar to the Windows Start menu, PTC Application Manager provides a 
menu that enables you to easily start and close applications on UNIX 
systems. You can configure the menu to include any application, 
including applications that are not developed by PTC. One key benefit is 
that Application Manager can be configured to activate Pro/ENGINEER 
from Pro/INTRALINK.

PTC Application Manager includes a menu command for each 
application it starts, giving you easy access on your desktop to those 
applications.

Note
To view PTC Application Manager in a language other than English, 
you must set the language variable before installing your software. 
For more information, see Setting Language Defaults on page B-20.

During installation, you can click Cancel at any time to stop the 
installation. PTC.Setup copies files and sets file permissions. 

Note
After installation, the optional settings can be reconfigured from the 
PTC Application Manager's Start > Preferences menu.

1. Under Other Products, click PTC Application Manager from the 
PTC.Setup product selection screen.

2. The Define Installation Components screen appears.

3. Define the following:

– Destination Folder—For new installations, keep the default 
installation directory, for example, /opt/ptc/
appmgrWildfire2.0, or specify the full path. PTC.Setup 
creates the specified new directory. You can also select a different 
installation directory.

For new installations, the directory that you specify must be new 
or empty.

– Features to install—Select the components and the 
subcomponents to install for PTC Application Manager.

– Platforms—Select the platform for the installation. Your 
machine's architecture is selected as the default platform.

– Languages—Select the required languages.

4. Click Next. The Configure Application Manager Settings screen 
appears.
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Configuring PTC Application Manager
You can optionally create Application Manager Start menu commands 
and customize settings when you configure PTC Application Manager. 
Each PTC.Setup tab lets you configure a different aspect of your PTC 
Application Manager installation.

To add or delete the names of programs from the Start menu after 
installing the PTC Application Manager,

1. Click Preferences. The PTC Application Manager dialog box opens.

2. The Start menu page lists commands for the PTC Application 
Manager Start menu. Use the following commands to configure the 
Start menu:

You can do the configuration dynamically when you start PTC 
Application Manager.

Creating Start Menu Commands
You can add the startup commands for the Application Manager Start 
menu (for example, the command proeWildfire2.0). With these 
commands, you can start and close applications easily using Application 
Manager.

Command Action

New Command Prompts for the name of a program or 
a command script. Adds that name to 
the list of available programs.

Modify Command Modifies the name of the program on 
the list.

Delete Command Deletes the selected program from the 
list.

Apply Applies the changes to the PTC 
Application Manager for the current 
session.

OK Saves changes to config.apm, a 
configuration file that preserves the 
list for later sessions.
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1. Click Add in the Configure Application Manager Settings screen. 
The Application Manager Configuration dialog box opens.

a. In the Type box, keep Pro/ENGINEER (default) or choose 
another product from the list. 

b. In the Label box, type the text you want to appear in the Start 
menu of the Application Manager.

c. In the Command line box, browse to or type the full path and the 
name of the command that you want the label to execute (for 
example, C:\ptc\proe\bin\proe.bat). This command 
executes the specified license and product type.
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2. Click OK in the Application Manager Configuration dialog box. You 
can Edit or Delete existing commands.

Note
After installation, you can add, modify, and delete commands 
from the Application Manager Start > Preferences menu.

Customizing the Application Manager Location
You can customize the appearance of PTC Application Manager as 
follows:

1. Click the Position tab as seen in the figure on the previous page, to 
customize the position of the PTC Application Manager. 

2. Specify where you want the toolbar to appear on your desktop: 
horizontal top, horizontal bottom, vertical left, or vertical right.

Using Auto Hide
You can also activate Auto Hide to display the Application Manager as a 
thin line. The Application Manager reappears when you move the 
pointer over the thin line.

Specifying Optional Configurations
After you have configured PTC Application Manager, you can specify the 
optional configuration steps as follows:

1. Click Next in the Configure Application Manager Settings screen to 
open the Optional Configuration Steps screen.

2. Click the Create links to product startup commands checkbox.

3. Click Next and specify a location to store the command links and 
utility scripts.

Completing PTC Application Manager Installation
After you have configured the installation, do one of the following 
operations:

• Click Back to review the information that you have specified earlier. 

• Click Install to begin installation. The Installation Progress screen 
displays the status of the installation. 
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• Click Next to install the next selected component.

• Click Exit to exit PTC.Setup.

During installation, you can click Cancel in the Installation Progress 
screen at any time to stop the installation. 

The Installation Progress screen announces a successful installation. If 
the installation fails, a ptcsetup.log file is created in the temp 
directory. It reports all the errors during installation.
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Installing PTC Help
This chapter provides an overview of the Help Center that you receive on 
the Pro/ENGINEER software CD-ROM. This chapter also explains how 
to install the Help system by itself rather than with Pro/ENGINEER 
software.
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Overview of the Help Center
The Help Center provides quick access to documentation for 
Pro/ENGINEER in the Pro/ENGINEER browser. The Help Center 
features:

• Context-sensitive Help organized by functional areas. Structural and 
Thermal Simulation (Mechanica) information is integrated with the 
Pro/ENGINEER Help topics.

• PTC Reference Documentation such as the PTC Customer Service Guide 
and the Pro/ENGINEER Wildfire 2.0 Installation and Administration 
Guide. To view and print these PDF books, you must have Adobe 
Acrobat Reader installed.

• A global search facility and quick links to helpful information.

Accessing Help
After you install the PTC Help component, you can access Help in an 
active session of Pro/ENGINEER in the following ways:

• Drag from the main menu bar to any item on the user interface.

• Click Help > Help Center. On the Help Center home page, you can 
use the menu bar, click a quick link, or click a functional area.

Viewing the Help Center
In an active session of Pro/ENGINEER, you can view the Help Center in 
the Pro/ENGINEER browser. Outside Pro/ENGINEER, you can use the 
Pro/ENGINEER browser or any of the following Web browsers:

• Internet Explorer 6.0 with SP1 or later

• Mozilla 1.4

You can view the Mechanica independent mode help using Netscape 6.2 
in addition to the above Web browsers.

Installing PTC Help
Using PTC.Setup you can install the Help Center in the product 
installation directory, elsewhere on your system, in a common Help 
directory, or on a Web server. When you install Pro/ENGINEER, you can 
install the Help Center in the product installation directory by default (for 
example, C:\Program Files\ptchelpWildfire2.0). See the 
procedure in Chapter 4, Installing and Starting Pro/ENGINEER.
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Installing the Help Center in a Common Help Directory
A common Help installation directory is advantageous when multiple 
PTC products are used. To install the Help Center in a common Help 
directory, follow these steps:

1. Start PTC.Setup using the steps outlined in Starting PTC.Setup on 
page 1-5.

During installation, you can click Cancel at any time to stop the 
installation. PTC.Setup copies files and sets file permissions.

To easily administer many client machines, install the Help Center on 
a network file server's hard disk. To service remote clients not on the 
local network, install the Help Center on a Web server's hard disk.

2. Under Other Products, click PTC Help on the PTC.Setup product 
selection screen.

3. The Define Installation Components screen appears.

4. Define the following parameters:

– Destination Folder—For new installations, keep the default 
installation directory (for example, C:\Program 
Files\ptchelpWildfire2.0) listed or specify the full path. 
PTC.Setup creates the specified new directory. You can also select 
a different installation directory.

For new installations, the directory that you specify must be new 
or empty.

– Under Features to Install, click  before each of the 
components and provide the following information:

Product Features—Choose the components that you want to 
install by clicking  next to the appropriate component. 
Select one of the following commands from the list that appears:

Install this feature—Install the component. 

Do not install this feature—Do not install the component.

Available are the Pro/ENGINEER Help files and the Mechanica 
independent mode Help files.

Platforms—Select the platform for the installation. Your 
machine's architecture is automatically selected as the default 
platform.

Languages—Select the required language.
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5. After you have selected your components, click Install. The 
Installation Progress screen announces the status of installation. You 
can also do one of the following operations:

– Click Cancel to cancel the installation.

– Click Back and review information. 

– Click Next to install the next selected component.

The Installation Progress screen announces a successful installation. 
If the installation fails, a ptcsetup.log file is created in the temp 
directory. It reports all the errors during installation.

6. Click Exit to quit the PTC.Setup installation utility.

Installing the Help Center on a Web Server
When installing the Help Center on a Web server, you must place the files 
within the Web server's document root directory (as specified during the 
Web server's installation).

Configure your Web server to distribute files from the installation 
directory as described in the previous section. If you installed the Help 
Center in the C:\Program Files\ptchelpWildfire2.0 directory, 
then point the Web server to that directory and set an alias of your choice.

For example, if you configure a Web server named Titan to distribute 
C:\Program Files\ptchelpWildfire2.0 with the alias /help, 
then specify http://titan/help as the Help path in the Help 
Location window.
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Installing Pro/Web.Publish
This chapter explains how to install Pro/Web.Publish. With 
Pro/Web.Publish you can set up your Web server and publish objects you 
created using Pro/ENGINEER. Installing Pro/Web.Publish is optional.

With Pro/Web.Publish, you can export assemblies, process assemblies, 
and manufacturing processes to a directory in a Web browser.

Topic Page

Overview 9 - 2
Configuring Your Web Server 9 - 2
Installing Pro/Web.Publish 9 - 6
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Overview
Installation of Pro/Web.Publish involves two processes:

1. Configuration of your existing Web server. The procedures differ 
depending on what kind of Web server you have:

– Apache Web Server (UNIX)

– Microsoft Internet Information Server (Windows NT)

– Microsoft Peer Web Services (Windows NT)

2. Installation of Pro/Web.Publish as a user with write permission to 
the Web server.

Locate the configuration procedure for your Web server in the following 
sections and, after configuration, install Pro/Web.Publish.

Configuring Your Web Server
Note
For all configuration procedures in this section, the variable <path> 
represents the full path to the installation directory for your Web 
server.

Apache Web Server
1. After downloading the Apache Web Server (www.apache.org), create 

the following directories in the apache_x.x.x directory:

– server_root

– home

where apache_x.x.x is the directory downloaded from the Apache 
Web site.

2. Copy the conf directory from the apache_x.x.x directory into the 
server_root directory created in the previous step.
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3. In the server_root/conf directory, create copies of the 
configuration files as indicated in the following table. The original file 
and the copy must both reside in the server_root/conf directory.

4. Edit the http.conf file according to your user status.

As a root user, locate the following lines:

User nobody
Group #-l

Replace nobody with root and replace #-l with sys for the 
previous lines.

As a nonroot user, locate the following line: 

Port 80

Replace 80 with a free communications port number that is greater 
than 1023 for the previous line.

5. Use a text editor to replace configuration lines in your http.conf 
file as indicated in the following table. Save the file.

Name of the Original File Name of the Copied File

httpd.conf-dist http.conf

access.conf-dist access.conf

srm.conf-dist srm.conf

Line Text to Replace Text Replacement

ServerAdmin you@your.address you@your.address The administrator’s electronic 
mail address

ServerRoot /usr/local/etc/httpd /usr/local/etc
/httpd

The full path to your 
server_root directory 
(.../apache_x.x.x/
server_root)

#ServerName new.host.name new.host.name The server host name
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6. Use a text editor to replace configuration lines in your access.conf 
file as indicated in the following table. Save the file.

7. Use a text editor to replace configuration lines in your srm.conf file 
as indicated in the following table. Save the file when you have 
finished editing it.

8. Use a text editor to add the following line to the mime.types file in 
the server_root/conf directory:

image/cgm cgm

9. Save the file after you have finished editing it.

10. Change directory to the Apache Web Server directory and start the 
Web server by entering the following command:

<path>/src/httpd-<platform> 
<path>/server_root/conf/httpd.conf

where <platform> is the platform on which you are running the 
Web server (for example, 
/disk1/apache_1.2.0/src/httpd-irix -f 
/disk1/apache_1.2.0/server_root/conf/httpd.conf).

Line Text to Replace Text Replacement

<Directory> 
/usr/local/etc/httpd/
htdocs

/usr/local/etc/httpd/
htdocs

The full path to the home directory 
created in step 1

<Directory> 
/usr/local/etc/httpd/
cgi-bin

/usr/local/etc/httpd/
cgi-bin

The full path to the cgi-bin 
subdirectory in the Apache Web 
Server directory 

Line Text to Replace Text Replacement

<Directory> 
/usr/local/etc/httpd/
htdocs

/usr/local/etc/httpd/
htdocs

The full path to the home directory 
created in step 1

#ScriptAlias 
/cgi-bin/ 
/usr/local/etc/httpd/
cgi-bin/

/usr/local/etc/httpd/c
gi-bin

The full path to the cgi-bin 
subdirectory in the Apache Web 
Server directory 
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Microsoft Servers
The following section describes how to configure the Microsoft Internet 
Information Server and Microsoft Peer Web Server. 

1. Rename the ...\InetPub\wwwroot directory to 
...\InetPub\home.

2. Create a directory called cgi-bin and a file called mime.typ in the 
<path>\InetPub directory.

3. From the Windows desktop, click Start > Programs.

4. From the Internet Information Services (IIS), select:

– Microsoft Internet Information Server (Common)

– Internet Services Manager

For Peer Web Services, select:

– Microsoft Peer Web Services (Common)

– Internet Services Manager

5. In the Internet Services Manager dialog box, double-click the server 
name on the line where www appears under the Service option. The 
WWW Service Properties dialog box opens.

6. Click the Directories tab from the WWW Service Properties dialog 
box. 

7. Change the value of Default Documentation from Default.htm to 
index.html and select the Enable Default Document and 
Directory Browsing Allowed check boxes.

8. Change the location of the document root directory by 
double-clicking the ...\InetPub\wwwroot listing.

9. In the Directory Properties dialog box, change the directory from 
...\InetPub\wwwroot to ...\InetPub\home and click OK.

10. Click Add from the WWW Service Properties dialog box. A new 
Directory Properties dialog box opens.

11. Select the Virtual Directory and Execute check boxes and enter 
cgi-bin for the Alias and <path>\InetPub\cgi-bin for the 
directory. 

12. Click OK.

13. Click Apply in the WWW Service Properties dialog box.
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14. Click OK.

15. If necessary, install plug-ins for your Web browser to allow viewing 
of CGM and VRML files.

Installing Pro/Web.Publish
1. Under Other Products, choose Pro/Web.Publish from the list of 

available software components. The Specify Web Server Paths 
screen appears.

During installation, you can click Cancel at any time to stop the 
installation. PTC.Setup copies files and sets file permissions. 

2. Under Pro/Web.Publish Configuration, define the following 
parameters if the PTC.Setup utility cannot detect the information:

– Cgi-bin Directory—This is the directory from which your server 
has permissions to execute programs. Your Web server must be 
configured to recognize this directory when referenced as 
http://<server>/cgi-bin. Type the full path to the 
directory you want to use or browse the folder hierarchy and 
specify the directory.

– Web Server MIME File—Type the location of the MIME type file 
on the Web server. Or, click the folder icon and browse to and 
specify the file. This file, which is usually called mime.typ on 
Windows and mime.types on UNIX platforms, is located in the 
configuration directory of the Web server. PTC.Setup adds the 
following lines to this file:

– Document Root Directory—Enter the location of the directory 
where your HTML files are stored on your Web server or click the 
folder icon, browse, and specify the directory. This is the 
directory from which your Web server reads documents when 
they are referenced as http://<server>/. This directory was 
specified during configuration of your Web server.

image/cgm cgm

x-world/x-vrml wrl vrml
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3. The Installation Progress screen displays the status of installation. 
You can also do one of the following operations:

– Click Cancel to cancel the installation.

– Click Back and review information. 

– Click Next to install the next selected component.

– Click Exit to quit the installation setup utility.

The Installation Progress screen announces a successful installation. 
If the installation fails, a ptcsetup.log file is created in the temp 
directory. It reports all the errors during installation.
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Installing and Starting

PTC Distributed Services
This chapter explains how to install and start PTC Distributed Services 
Manager (DSM).

Topic Page

Installing Distributed Services Manager 10 - 2
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Completing the Distributed Services Manager Installation 10 - 9
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Installing Distributed Services Manager
You install Distributed Services Manager after you have installed PTC 
License Server. You can install your product software on a license server, 
a license client, or on any combination of these machines. Successful 
installation of your product software requires three major steps:

• Defining your installation components, including the installation 
directory

• Specifying the location of the license servers

• Starting the software

To view Distributed Services Manager in a language other than English, 
you must set the language variable, LANG, before running your software. 
For more information, see Setting Language Defaults on page B-20.

Defining the Installation Components
1. Start PTC.Setup using the steps outlined in Starting PTC.Setup on 

page 1-5. The PTC.Setup product selection screen appears.

During installation, you can click Cancel at any time to stop the 
installation. PTC.Setup copies files and sets file permissions.

2. Under Other Products, click PTC Distributed Services. The Accept 
License Agreement screen appears. Accept the agreement to proceed.

At this point, you must have already installed PTC License Server.

Note
When you perform an update or install a new release of a PTC 
product you must update your license information.

The Define Installation Components screen appears.
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3. Define the following parameters:

– Destination Folder—For new installations, keep the default 
installation directory, for example, C:\Program Files\
ptc_distributed_services, or specify the full path. 
PTC.Setup creates the specified new directory. You can also select 
a different installation directory.

For new installations, the directory that you specify must be new 
or empty.
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– Under Features to Install, click  before each of the 
components and provide the following information:

Product Features—Choose the components that you want to 
install by clicking  next to the appropriate component. 
Select one of the following commands from the list:

Install this feature—Install the component. 

Do not install this feature—Do not install the component.

The available product components are:

Distributed Services Manager—Select this component to install 
the files to run the software. The amount of disk space required is 
also displayed.

API Toolkits—Select this component to optionally install the 
Application Programming Interface toolkits like C API and Java 
API. The API allows you to build Distributed Services 
applications.

PTC.Setup—Select this component to install PTC.Setup for 
future configuration of the software. With this utility, you can 
make configuration changes without running PTC.Setup from 
the CD-ROM.

Platforms—Select the platform for the installation. Your 
machine's architecture is automatically selected as the default 
platform.

Languages—Select the required languages.

4. Click Next after you have selected your components. The Flexlm 
license servers screen appears.
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Specifying the Location of the License Server
The PTC.Setup installation utility can access your license information on 
a remote license server or on a local machine. Your next task is to specify 
the locations of the license servers that you want this installation of your 
product software to access.

Note
PTC does not provide locked licenses for Distributed Services 
Manager.
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Distributed Services Manager uses two different license features: 
DS_MANAGER and DS_SERVICE. You need both to fully use the 
Distributed Services Manager. The Distributed Services Manager will not 
be able to receive any incoming tasks without the DS_MANAGER license 
feature and it will not be able to process incoming tasks without the 
DS_SERVICE license feature. After specifying the license servers, click 
Server Info to verify that both these license features are available.

If you access your license information from a machine without a valid 
version of FLEXlm, an error message tells you to update PTC License 
Server. Refer to the READ THIS FIRST document for the latest 
information about FLEXlm.

Specifying the License Server
Depending on the location of PTC License Server, provide PTC.Setup 
with the location of your licensing information.

• If PTC License Server resides on the machine on which you are 
installing the software, and you have used the default 
communications port for the license server, you do not have to 
specify the license server. PTC.Setup detects the server name and 
adds it to the Flexlm License Servers list box.

• If PTC License Server resides on a different machine, you must 
specify the license server. See the following section Obtaining a 
License from a Server or Servers on page 10-6

Specifying the License Client
If you are installing the software on a license client without PTC License 
Server installed, the Flexlm License Servers list box is initially blank. To 
enable this installation to obtain floating licenses from a remote server, 
you must define which servers are distributing the licenses. See 
Obtaining a License from a Server or Servers on page 10-6. 

Note
You cannot run the Distributed Services Manager installer without a 
license. 

Obtaining a License from a Server or Servers
To obtain a license from a server or servers:

1. Click Add in the Flexlm license servers screen (see the previous 
screen). The Specify License Server dialog box opens. 
10-6 Installation and Administration Guide



2. Click one of the server options and enter the requested information.

– Single license server—Specifies a single server for the licenses. 
Type the host name and the communications port number if it is 
different from the default. This information identifies the server, 
for example, aberdeen, from which this installation obtains its 
license codes.

– Triad license server (fault tolerant)—Specifies a Triad 
configuration of three Triad partners. As long as two or more 
partners are running, the licenses are served. If two or more 
partners are not functioning, the server stops serving the licenses.

Define all three license servers. Each Triad license server must 
have the same license file. 

Note
The order of the server list (Triad Partner 1, Triad 
Partner 2, Triad Partner 3) must be the same on all 
the three license servers.
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PTC recommends that the Triad license servers be at the same 
site. For further information on redundant license servers, see the 
FLEXlm End Users Guide.

Note
Do not specify the host name of the client nodes. Specify only 
the license server that controls usage of the licenses. You can 
use the Specify License Server dialog box to configure the 
clients to access multiple servers or license files across your 
network.

On Windows systems, either the fully qualified server name or 
the IP address must identify the server.

3. Click OK to add the server and communications port information to 
the Flexlm License Servers list box. For example, 7788@aberdeen.

4. Click Next. Further steps are optional and vary for Windows and 
UNIX systems.

Performing Optional Configuration Steps
Setting shortcut preferences and creating links to startup commands are 
optional.

Setting Shortcut Preferences (Windows Only)
Set the following shortcut preferences:

• Shortcut Location(s)—You can start the Distributed Services 
Manager from the desktop, the Start menu, the Start > Programs 
menu, or any combination of these three options. 

• Program Folder—If you select Program folder as the shortcut 
location, specify the name of the folder and option in the Programs 
menu. 

• Startup Directory—Specify the name of the Distributed Services 
Manager startup directory.

You can set the following Windows environment preferences:

• Modify system environment for all users—Sets the system PATH 
variable for all users on the system.

Note
You must have the administrator privileges to set the system 
environment variable for all users.
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• Modify current user’s environment only—Sets the user’s PATH 
variable for the current user on the system.Click Install. The 
Installation Progress screen appears. See the section Completing the 
Distributed Services Manager Installation on page 10-9.

Creating Links to Startup Commands (UNIX Only)
Command names are the script names that PTC.Setup uses to enable you 
to start the software from your workstation. These scripts maintain the 
relationship between licensing on the server and your client software 
command. On Windows, for example, the default command name, 
ptcdsm, results in the creation of a executable file and, optionally, a 
shortcut icon. This icon is linked to the executable that starts Distributed 
Services Manager. On UNIX, the standard startup command ptcdsm is 
created in the bin directory.

By keeping the default Create links to product startup commands 
checked, you can create a link from the /bin directory in your 
installation directory to another directory on your UNIX system. (If this 
other directory is in your path environment setting, then simply entering 
the command name starts Distributed Services Manager.) 

To create a link, use the Startup command links screen to type the full 
path or browse to the directory in which you want the link created. 

1. Click Create links to product startup commands in the Optional 
Configuration Steps screen and click Next. The Startup Command 
Links screen appears.

2. Type the full path or browse to the directory in which you want the 
link created.

3. Click Install. The Installation Progress screen appears. 

See the next section to complete the installation.

Completing the Distributed Services Manager 
Installation

The Installation Progress screen displays the status of installation. In this 
screen you can also do one of the following operations:

• Click Cancel to cancel the installation.

• Click Back and review information. 

• Click Next to install the next selected component.
Installing and Starting PTC Distributed Services 10-9 



The Installation Progress screen announces a successful installation. If 
the installation fails, a ptcsetup.log file is created in the temp 
directory. It reports all the errors during installation. 

Click Exit to quit the PTC.Setup installation utility.

Starting Distributed Services Manager
After your license management and product software has been installed, 
start Distributed Services Manager. 

Windows 
Click Start > PTC > PTC Distributed Services > Distributed Services 
Manager to start Distributed Services Manager.

UNIX
From a UNIX prompt, navigate to the Distributed Services Manger 
installation directory and execute the command ptcdsm. For example, 
/opt/ptc/ptc_distributed_services/bin/ptcdsm.

Removing Distributed Services Manager 
(Windows Only)

You can remove your Distributed Services Manager software through the 
Control Panel. This procedure is for Windows systems only.

1. From the Start menu, click Settings > Control Panel.

2. Double-click the Add/Remove Programs icon. The Add/Remove 
Programs dialog box opens.

3. In the program application list, highlight the release of Distributed 
Services Manager to remove.

4. Click Remove. You see the PTC Uninstall dialog box.

5. Click Uninstall or Cancel to escape. You are presented with a series 
of confirmation statements to remove files. 

6. Click Uninstall to proceed. Distributed Services Manager is removed.
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Updating and Modifying an

Installation
This chapter explains how to update or modify PTC software on your 
system. The procedures in this chapter are for updating and modifying of 
installations only.

Note
• Because FLEXlm, PTC License Server, was implemented in 

Release 20, you can update Release 20 and later versions with 
Pro/ENGINEER Wildfire 2.0. 

• Each time you update your software, you must update your 
license file. New license codes are not required if you are 
updating to a new build of Pro/ENGINEER within the same 
release.

Topic Page
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Updating Pro/ENGINEER
An update installation is needed in the following cases:

• Upgrading your PTC software to the next major release (for example, 
Release 2001 to Wildfire 2.0)

• Upgrading your current release to a later release

• Updating the current datecode to include additional software

Update installations overwrite the outdated files in your Pro/ENGINEER 
installation directory with files from the most recent release or build.

After you install Pro/ENGINEER Wildfire 2.0, you can perform 
incremental updates. An incremental update adds only newly selected 
components to the existing installation. The components of the existing 
installation remain unchanged. 

Note
When performing incremental updates, if the current installation 
is corrupt, you cannot update the installation to replace missing 
or corrupt files for the same datecode. In such cases, uninstall and 
reinstall Pro/ENGINEER.

If you update an existing installation with a different release of the 
software, all components of the existing installation are replaced with the 
new components.

Before updating an installation, load and mount the software CD-ROM 
and start the PTC.Setup installation utility. New license information is 
required when you update to the next release.

To update the product software on remote servers, node-locked 
machines, or license clients, repeat the steps in Chapter 4, Installing and 
Starting Pro/ENGINEER.

During installation, you can click Cancel at any time to stop the 
installation. PTC.Setup copies files and sets file permissions. 

Modifying Pro/ENGINEER
Modifying Pro/ENGINEER implies creation of new startup commands 
and reconfiguration of existing software components. No new license 
information is required when you modify an installation.

If you are modifying an existing installation of Pro/ENGINEER, you can 
start PTC.Setup by using the ptcsetup command, in the bin directory 
of your installation path (C:\Program Files\proe\bin). 
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You can also rerun the PTC.Setup installation utility from the CD-ROM 
and make modifications. 

Obtaining a New License Pack
If you are installing a new, major release of Pro/ENGINEER, you must 
update PTC License Server before you install your new software. 

It is highly recommended that you obtain an electronic copy of your new 
PTC License Pack. Using PTC.Setup, you can quickly and easily import 
either the new license file or append the existing license file with your 
new license codes.

For information on how to obtain your License Pack online, see Receiving 
Your License Pack on page 1-3.

Updating License Codes
You can update FLEXlm, PTC License Server, with your new license file 
when updating your PTC software.

Note
If the license server also has Pro/ENGINEER installed, the installed 
ptcsetup utility can be used to update licensing information.

Perform the following steps:

1. Start the PTC.Setup installation utility. The PTC.Setup product 
selection screen appears after the Welcome screen. 

2. Click PTC License Server. The Define Installation Components 
screen appears.

3. Keep the default installation directory for PTC License Server if this is 
where your FLEXlm software resides. 

4. Specify a license file by browsing to the folder that contains the 
encrypted license file. You can also drag your license file into the 
License File text box. The large box under License File displays the 
information contained in the license file.

Note
To proceed, you need the new licensing information in your PTC 
License Pack. If you have not already done so, request a new 
License Pack. For detailed information, see Receiving Your 
License Pack on page 1-3.

There are several ways to update an existing license file. However, it 
is strongly recommended that you import the new license file. The 
new license file contains all of your new license codes as well as any 
Updating and Modifying an Installation 11-3 



that are still in effect. Note that importing the new license file 
overwrites the existing file.

You can also import and append the existing license file with your 
new license data. For information on how to append a license file or 
manually enter your license codes by typing the information or by 
using the License Wizard, see Chapter 3, Installing PTC License 
Server.

5. Optionally, click Flexlm Server Options to specify the following:

– Directory in which you can create links.

– Server process owner (UNIX only).

– The license server startup options.

– The command line arguments. This gives the administrator the 
control over the server processes. See FLEXlm End Users Guide for 
further details.

– Start the license server if the system is rebooted.

6. Click Install to start the installation of the license server. Upon 
completion, PTC.Setup starts the license server.

7. Click Next to install the next selected component or exit PTC.Setup.

PTC.Setup restarts the FLEXlm license server. For Triad configurations, 
two of the three partner machines must be running before licenses can be 
distributed.

Updating and Modifying Pro/Web.Publish
Updating Pro/Web.Publish requires only that you update your existing 
Pro/Web.Publish installation. You do not have to reconfigure your Web 
server.

Note
To update or modify Pro/Web.Publish, you must have write 
permissions on the Web server.

To update an installation of Pro/Web.Publish, start PTC.Setup using the 
Pro/ENGINEER CD-ROM or the ptcsetup command if you installed 
this utility. To update the product software, repeat the steps in Chapter 9, 
Installing Pro/Web.Publish.

To modify an installation of Pro/Web.Publish, start PTC.Setup and 
change the configuration information you specified during installation.
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License Management

Software
This appendix discusses license management software and describes the 
benefits of PTC License Server. License simplification is explained for 
new and existing Pro/ENGINEER users.

Topic Page
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Overview of PTC Licensing
PTC software including PTC optional applications must be licensed for 
use. Licensing authorizes the installed software to run. PTC supports the 
following types of licenses:

• Commercial—Commercial licenses are not time-sensitive licenses.

• Evaluation—Evaluation licenses limit your use of the software to a 
specified time period.

• Educational—Educational licenses, which are used at educational 
institutions, are time-sensitive licenses (also known as student 
licenses). Also, the objects created in an educational or student 
version of Pro/ENGINEER are not compatible with the commercial 
version.

Depending on the product, the licenses can be either locked, extended, 
floating, or borrowed.

• Node-locked license—A node-locked license restricts the use of the 
software to a particular machine (independent workstation). A 
node-locked license also restricts the DISPLAY setting on UNIX 
workstations.

Note
Node-locked licenses are not available for all PTC products, such 
as Pro/INTRALINK.

• Floating license—A floating license can be used on any one of a 
group of machines on your network.

• Extended license—An extended license makes floating licenses 
available for locked modules.

• Borrowed license—A borrowed license allows you to work 
temporarily on your machine without being connected to the license 
server. Refer to License Borrowing on page A-11 for details.

Simplified License Management Process
Pro/ENGINEER provides an easy license configuration, installation, and 
tracking process. This process provides flexibility in configuring your 
licenses and minimizes the number of generated Service Contract 
Numbers (SCNs). You can combine all the Pro/ENGINEER licenses and 
options into a single SCN along with the Pro/INTRALINK or Structural 
and Thermal Simulation licenses. You can also assign a single SCN to the 
required license server.

Each PTC product is defined in the license file with a unique feature 
name. This license file format follows a standard approach by using the 
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PTC License Server. Floating licenses can be configured to be acquired 
when you start Pro/ENGINEER.

Note
License configuration is a part of the installation process.

Visit www.ptc.com/olm/ls_faq for the License Simplification Overview.

License Simplification—Advantages
• Increased flexibility in managing PTC licenses—With the license 

configuration process integrated into the installation process, you can 
alter the assignment and configuration of functions without 
contacting the PTC License Management team.

• Fewer licensing rules—Licenses are assigned to a machine through a 
SCN (Service Contract Number).

• Stable number of licensing SCNs—With no licensing requirements 
for SCNs, you have significantly fewer SCNs to manage. License 
changes do not force you to change the SCN.

• Reduced time associated with licensing PTC products—You and 
PTC do not need to research and maintain the tight control over the 
multiple types of licenses based on how you purchased the products 
originally.

• Reduced system administration time for license changes—With the 
use of common feature names in licenses, updates to the client are 
reduced as the licenses are moved between servers. The feature name 
and the startup commands remain the same.

License Simplification—General Information
• License simplification is integrated with all products of the 

Pro/ENGINEER family and is available in Pro/ENGINEER 2001 
datecode 2001440 and later.

• To use Pro/ENGINEER Wildfire 2.0, you must perform license 
simplification, if you have not already done so, to receive a new 
license pack of version 25 or later that is compatible with 
Pro/ENGINEER Wildfire 2.0.

• Use the License Support Web tool called Reconfigure Software 
Licenses on the PTC Order and License Support page at 
www.ptc.com/olm/index.htm. Use this tool to upgrade to the new 
licensing scheme. The tool automatically consolidates the licenses 
into a selected Service Contract Number (SCN) and returns an 
updated license file.
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License Simplification—Technical Information
• License simplification has changed the license file format and the 

PTC.Setup utility. 

Note
Pro/ENGINEER requires FLEXlm version 8.4a or later for license 
simplification.

• The format of the FLEXlm feature line in the license file has two 
changes due to license simplification:

– The SCN is no longer a part of the feature name and is moved 
below the SN tag in the feature line.

– A new classification of floating license called a License Extension 
is available for all locked modules and extensions. This new 
classification is identified by the keyword STARTUP in the 
Vendor String.

License extensions are available for checkout only at runtime, that is, 
when starting a base license. You cannot add or release the License 
Extension using the Tools > Floating Modules dialog box.

The following license file is an example of a license-to-run license and 
a floating license bundle under the license simplification scheme. The 
new areas described earlier appear in bold:

INCREMENT PROE_FlexEng ptc_d 25.0 01-jan-04 \

        1CCBD4992306440F61A0 VENDOR_STRING="VSVER=2.0 BORROW LO=(0, \

        3, 6, 7, 10, 17, 19, 32, 34, 40, 45, 51, 52, 55, 62, \

        63, 66, 69, 71, 73, 97, 106, 108, 115, 126, 127, \

        128, 158) BORROW" HOSTID=PTC_HOSTID=00-CC-DD-33 SUPERSEDE \

        vendor_info="VIVER=1.0 EXTERNAL_NAME=" ISSUER=PTC \

        ISSUED=09-nov-2003 NOTICE=" PTC_CUSTOMER, 000" \

        SIGN=1234568 BORROW=120

INCREMENT 10118 ptc_d 25.0 01-jan-04 AC2BD4A9DB54B88A6429 \

        VENDOR_STRING="VSVER=2.0 STARTUP BORROW LO=()" SUPERSEDE \

        ISSUER=PTC ISSUED=09-nov-2003 \

        NOTICE="PTC_CUSTOMER, 000" BORROW=120

INCREMENT PROBUNDLE_10118 ptc_d 25.0 01-jan-04 \

        5C9B8499D4B428AA6E42 VENDOR_STRING="VSVER=2.0 BORROW\

        LO=(32, 52, 63)" HOSTID=ANY SUPERSEDE ISSUER=PTC \

        ISSUED=09-nov-2003 NOTICE=" PTC_CUSTOMER, 000" BORROW=120
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• Using the PTC.Setup utility, you can define startup commands with 
additional license extensions or floating options. When you add 
license extensions, or floating options, to a startup command, a value 
is assigned to the PROE_FEATURE_NAME variable. This variable is 
defined in the Pro/ENGINEER startup command. The following 
example shows valid syntax for a UNIX operating system.

PROE FEATURE NAME before license simplification:

setenv PROE_FEATURE_NAME PROE_1274228

PROE FEATURE NAME after license simplification:

setenv PROE_FEATURE_NAME PROE_FlexEng (10118,32)

In addition to checking the PROE_FlexEng license, the availability of 
the bundle 10118 and the floating option 32 is also checked. If some 
bundles or options are not available, a warning appears listing them. 

• During a session, if a license is lost and you try to recover the 
license-to-run, Pro/ENGINEER attempts to reacquire the 
license-to-run and all other options specified in the startup 
command.

• The output of the Ptcstatus utility provides the location of the SCN in 
the license file. You can use the Ptcstatus utility in two modes: 

– Normal mode—Run the Ptcstatus utility at the command line 
without any arguments.

ptcstatus

– Verbose mode—Run the Ptcstatus utility at the command line 
with the -v argument.

ptcstatus -v
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The following output illustrates the difference between the two 
Ptcstatus utility modes:

Ptcstatus Normal Mode

Ptcstatus Verbose Mode

Displaying status for license file: 7788@static

License Server: static

License In Use Free

----------- ------ ---

PROE_FlexEng Uncounted, Locked

Foundation_Adv 0 2

Pro/SURFACE * 0 2

Behavioral_Modeler 0 2

Pro/PlasticAdvisor 0 2

ModelCHECK 0 1

Tool_Design_SET * 0 2

* = License Extension - Available only on startup

Displaying status for license file: 7788@static

License Server: static

ptc_d FLEXlm version: 8.4a

License In Use Free Version Expire 
Date

SCN

----------- ------ --- ------ ------ --------

PROE_FlexEng Uncounted 24.0 None FlexEng Locked 
to 
00-10-83-FF-B5-
75

Foundation_Adv 0 2 24.0 None 12345

Pro/SURFACE * 0 2 24.0 None

Behavioral_Modeler 0 2 24.0 None

Pro/PlasticAdvisor 0 2 24.0 None

ModelCHECK 0 1 24.0 None

* = License Extensions - Available only on startup
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• You can specify a name for a license instead of its default name by 
changing the value of the attribute EXTERNAL_NAME in the feature 
line of the license file.

For example, to change the feature PROE_FlexEng to My License 
Name in a license file, specify the value of the EXTERNAL_NAME 
attribute as shown in the original and changed files.

Original license file:

Changed license file:

Notice the text after the EXTERNAL_NAME attribute in the changed 
license file. With this change, the output of the Ptcstatus utility 
displays the new name, My License Name, instead of 
PROE_FlexEng.

PTC License Server
Macrovision Corporation’s FLEXlm license management software is 
integrated with PTC software. For more information, visit 
www.macrovision.com. 

Benefits of Using FLEXlm
Using FLEXlm to control usage of licenses offers the following key 
advantages:

• Single-Server Solution—FLEXlm can manage PTC software and 
other vendor applications without conflict. Note that the PTC license 
file cannot be combined with the license files of other vendors.

INCREMENT PROE_FlexEng ptc_d 25.0 1-jan-04\

        4C5570EB8496F36B500F VENDOR_STRING=”VSVER=2.0 BORROW \

        LO=(3,7,10,17,34,40,45,51,55,62,66,69,71,73,106,115,126,163)” \

        SUPERSEDE vendor_info=”VIVER=1.0 BORROW=120 \

        EXTERNAL_NAME=”ISSUER=PTC \

        ISSUED=17-feb-2003 NOTICE=”PTC Internal Use Only”

INCREMENT PROE_FlexEng ptc_d 25.0 1-jan-04\

        4C5570EB8496F36B500F VENDOR_STRING=”VSVER=2.0 BORROW \

        LO=(3,7,10,17,34,40,45,51,55,62,66,69,71,73,106,115,126,163)” \

        SUPERSEDE vendor_info=”VIVER=1.0 \

        EXTERNAL_NAME=My License Name”ISSUER=PTC BORROW=120 \

        ISSUED=17-feb-2003 NOTICE=”PTC Internal Use Only”
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• Immediate License Recovery—If there is a premature exit of the 
licensed software (for example, the system shuts down), the FLEXlm 
license server automatically reclaims the PTC license. 

• Increased Flexibility—System administrators can reserve or deny 
licenses based on user name, host name, display name, or IP address. 
For more information refer to Chapter 5, The Options File, in the 
FLEXlm End Users Guide. 

• Centralized License Storage—PTC customers can store all PTC 
licenses for all PTC products in a single file for each license server.

• Multiple Licenses for a Single Command—One command can be 
used to execute multiple licenses of PTC software based on 
availability. 

• License Borrowing—Using Flexlm 8.4a or later, you can borrow 
licenses from a license server and run a licensed application on a 
remote client without being connected to the license server.

Downward License Compatibility Using FLEXlm
FLEXlm license servers have downward compatibility with PTC 
applications using FLEXlm. For example, a Pro/ENGINEER Wildfire 2.0 
license can run Pro/ENGINEER 2001 software, because both releases of 
the software use FLEXlm licensing.

FLEXlm cannot serve licenses to an installation using Pro/SERVER 
(Release 19 and earlier). However, Pro/SERVER and PTC License Server 
can run on the same machine in parallel.

Running FLEXlm with Other Applications
You can use FLEXlm to run PTC products as well as other applications. 
Each vendor application that uses FLEXlm has its own lmgrd or FLEXlm 
daemon. The FLEXlm daemon starts the vendor daemon (for example, 
ptc_d), which controls the usage of licenses. Macrovision strongly 
recommends that the lmgrd daemon program be run as a nonprivileged 
(not root) user on UNIX systems.

Note that you cannot combine a PTC license file with a license file of 
another vendor. Do not, for example, combine PTC feature lines with 
those of other vendors in a single license file. This action causes the 
licenses to be invalid.

If all applications and vendor daemons are FLEXlm 6.1 or later, lmgrd 
can process multiple license files. This is true even when the Host IDs are 
different (as long as the license files refer to the same node). Refer to the 
chapter on multiple license files in the FLEXlm End Users Guide.
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Understanding Timeout Parameters
Timeout parameters enable the license client and the license server to 
communicate with one another so that licenses are released and available 
upon request.

You can reconfigure the TIMEOUTALL parameter within a specified range, 
as described in the next section, Changing the Inactivity Timeout 
Parameter.

Timeout Parameter Value Description

Inactivity timeout 
(TIMEOUTALL)

120 
minutes 
(default)

This parameter prevents a license from remaining idle. If the 
license client is inactive for a specific period, the license can 
be reclaimed by the license server and used by another 
license client. In Pro/ENGINEER, the inactivity timeout 
default is 120 minutes.

Activity is measured as active menu selections.

You can change the default of 120 minutes so that the 
parameter ranges from 20 minutes (minimum value) to 
infinity (maximum value).

Validation that the 
license is available

1 minute After each 1 minute interval, the next time you select a 
menu, the license client communicates with the license 
server. The license client queries the server whether the 
license is still available. The application has a minimum of 1 
minute to validate the license.

Validation retries None The first time a license client cannot validate its license the 
application's graphical user interface will freeze. You are 
immediately given the following three options:

Click Retry to request a license from an active license 
server.

Click Save File(s).

Click Exit to close the application without saving the file or 
files.

Startup 10 seconds Upon starting a session, the license client requests a 
license and has 10 seconds in which to have the request 
validated.
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Changing the Inactivity Timeout Parameter
You can set the TIMEOUTALL parameter that determines how long the 
system allows a license to remain idle before it is reclaimed by the license 
server. To change the default inactivity timeout parameter, you must 
update the FLEXlm option file, ptc.opt in <ptc License Server 
loadpoint>/flexlm/licensing. The default is 120 minutes.
Edit the default parameter 

TIMEOUTALL 7200

by changing 7200 seconds (120 minutes) to another value in seconds.

The minimum value is 20 minutes (or 1200 seconds) and the maximum 
value is infinity. To make infinity the default, remove the TIMEOUTALL 
parameter from the ptc.opt file. If you set a minimum value to less than 
20 minutes, the system defaults to 20 minutes.

Suppressing the Regained Network License Dialog Box
Beginning with Pro/ENGINEER 2000i, you can disable the Regained 
Network License dialog box using a configuration option. In the 
config.pro file, set the suppress_license_loss_dialog option to 
yes. The default is no. If you lose or regain your network license-to-run 
license Pro/ENGINEER, a status message appears but a dialog box does 
not.

Using the Ptcflush Utility
The Ptcflush utility is necessary only when a license client application 
shuts down in a way that does not break the TCP/IP connection between 
the license server and the client. This situation most commonly occurs 
when a client exits prematurely, or does not respond, or when the 
network connection between the license server and the license client is 
interrupted. Normally, it is not necessary to use Ptcflush utility.

You are allowed to use the Ptcflush utility once every 12 minutes. The 
syntax is as follows:

% ptcflush feature_name hostname port handle

Execute the ptcstatus command to list the <feature host port 
handle> information and copy and paste this listing at the command 
prompt to run Ptcflush.
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To flush a license in use, for example, type

% ptcflush PROE_2 titan 7788 101

using the feature name and not the user-defined name if you assigned an 
alias.

Note
On UNIX systems, you can use root privileges to flush user licenses. 
However, you must flush licenses individually. You cannot flush 
multiple licenses simultaneously.

License Borrowing
With license borrowing for all supported platforms, you can use 
Pro/ENGINEER applications on clients without being connected to the 
license server. The license server must be running Flexlm 8.4a or later and 
must use the License Pack of version 25. With license borrowing, you can:

• Choose from a pool of available licenses

• Specify the expiration date of the license

• Work remotely on design and manufacturing projects

To borrow licenses, you must request that PTC insert a borrowing 
keyword in the feature line of your license file. License borrowing is 
enabled only on request. You can configure your licensing on your license 
server, and not through License Management. See the FLEXlm End Users 
Guide for details. Following is an example of a license file with the license 
borrowing keyword:

INCREMENT_PROE_FOUND_WLO ptc_d 25.0 1-jan-04\

2CC530AB6B9FDB2EAAA3 VENDOR_STRING=”VSVER=2.0 BORROW \

LO= (3, 7, 10, 17, 19, 34, 40, 45, 51, 55, 62, \

66, 69, 71, 73, 106, 115, 126, 163) “ \

HOSTID=PTC_HOSTID=00-C0-4F-8E-F2-7D SUPERSEDE BORROW=120 \

Feature_Key=BORROW

vendor_info=”VIVER=1.0 EXTERNAL_NAME=” ISSUER=PTC \

ISSUED=18-Dec-2003 NOTICE=”PTC Internal Use Only”
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Initiating License Borrowing
You can initiate license borrowing by:

• Executing a batch file available in the \<proe_loadpoint>\bin 
directory

• Specifying the command-line argument to borrow licenses as 
discussed in the FLEXlm End Users Guide

proe_borrow.bat File
Connect to the appropriate PTC License Server and use the 
proe_borrow.bat file to initiate license borrowing. Use the following 
procedure:

1. Browse to the \<proe_loadpoint>\bin directory and run the 
proe_borrow.bat file on Windows. On UNIX, this file is called 
proe_borrow. This file opens a dialog box in which you can specify 
a startup configuration.

2. Under Startup Configurations, select the required startup 
configuration.
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3. Specify the number of days that you want the borrowed license.

The start date for borrowing the license is today’s date. The end date 
is based on the number of days that you request.

4. Click Start to start Pro/ENGINEER in the Borrow Configuration 
mode.

5. After starting Pro/ENGINEER, click Tools > Floating Options to 
select the additional floating options that you would like to add to the 
borrowed license.

6. Configure the borrowed license to create the required borrowed 
license.

7. Exit Pro/ENGINEER. 

On Windows, the license is created on the local machine in the 
registry under current user. On UNIX, the license is created in the 
$HOME/.flexlmrc directory. The LM_BORROW environment 
variable is created and contains all your borrowed licensing 
information. 

8. Disconnect from the license server and use the borrowed license.

Note
A borrowed license can contain multiple borrowed 
configurations that can expire at any time. Each time you start 
Pro/ENGINEER using the borrowed license, Pro/ENGINEER 
checks for and removes the expired borrowed license files. You 
can borrow licenses again, if required.

Determining the Borrowed License Status
You can run Ptcstatus for the following information on borrowed license 
status:

• Licenses that have been borrowed

• Expiry for each of the borrowed licenses

• License server information for borrowing licenses

• Local borrowed license information
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System Administration

Information
This appendix describes general system administration information, 
including system management utilities and machine configuration 
settings.
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Temporary Directories
Pro/ENGINEER uses the temporary directory as defined by your system 
environment to store Pro/ENGINEER parts. You can modify the location 
of the temporary directory by setting the temporary directory 
environment variable in the Pro/ENGINEER startup window before you 
run Pro/ENGINEER. On Windows systems, this environment variable is 
TMP. On UNIX systems, this environment variable is TMPDIR.

System Management Utilities
This section briefly describes Pro/ENGINEER and FLEXlm utilities. The 
files listed in the next two tables, Pro/ENGINEER Utilities and FLEXlm 
Utilities, are installed into the bin directory of your installation directory. 
On UNIX systems, symbolic links may have been made to these files from 
a user-specified directory. Further information can be found in the 
FLEXlm End Users Guide.

Pro/ENGINEER Utilities
You execute the Pro/ENGINEER commands, listed next, from the 
\<proe loadpoint>\bin directory when the license server is 
running. The load point is the directory where the software is installed.

Command Function

ptchostid Returns the PTC Host ID with required formatting used for FLEXlm license 
codes.

proewildfire
2

Runs Pro/ENGINEER. Can be user-defined.

ptcflush Releases licenses. This may be necessary if there are network problems. 
Formerly called proflush.

ptcsetup Runs PTC.Setup from disk. Allows you to reconfigure an existing installation 
without running PTC.Setup from the CD-ROM. The command, located in the 
bin directory, is created during installation.You use ptcsetup for modifications 
or reconfigurations only. It cannot install your PTC software.

ptcstatus Displays information on the current usage and availability of licenses.
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FLEXlm Utilities
You execute the FLEXlm commands, listed next, from the \<flexlm 
loadpoint>\flexlm\bin directory when the license server is 
running.

Lmtools Utility (Windows Only)
With FLEXlm 7.0 and later, a lmtools.bat program is added to the 
FLEXlm installation directory on Windows platforms only. The 
lmtools.bat program runs the PTC License Management tools utility 
that is started from the Start > Programs > PTC License Server tools 
menu. Functionality includes starting and stopping the FLEXlm license 
server from the Start/Stop/ReRead tab.

Machine-Specific Configuration
The sections that follow describe machine configuration procedures so 
that you can take full advantage of Pro/ENGINEER features.

Command Function

lmtools Runs the PTC License Management tools utility lmtools.bat on Windows 
systems only. Functionality includes customer configuration of the FLEXlm 
service, starting and stopping the lmgrd license server(s), server and 
licensing status, as well as diagnostic tools. On Windows systems, the 
shortcut icon created in Start > Programs > PTC License Management 
tools starts the Lmtools graphical user interface. The lmutil script provides 
the same information in text-based format for UNIX users

lmutil Provides optional arguments to check the server and licensing status. Refer 
to the FLEXlm End Users Guide.

ptcshutdown Shuts down a license server process for administrative maintenance of the 
license server. On Windows systems, you can also use the FLEXlm Control 
Panel to stop a license server process.

ptcstartserver Starts a license server process. On Windows systems, you can also use the 
FLEXlm Control Panel to start a license server process. See License 
Administration Tools in the FLEXlm End Users Guide.
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Hewlett-Packard Company
Machine configuration changes may be necessary to run PTC software on 
Hewlett-Packard machines. For complete details, go to the 
Hewlett-Packard technical support area and read Frequently Asked 
Questions and Tuning HP-UX for Pro/ENGINEER.

Silicon Graphics, Inc.
Machine configuration changes may be necessary to run PTC software on 
Silicon Graphics, Inc. machines.

Silicon Graphics 4Dwm Windowing Environment
Pro/ENGINEER supports the 4Dwm windowing environment on Silicon 
Graphics machines. Certain resource files may need to be updated in 
order to use this windowing environment. These updates can be made 
manually or you can use the script called 4Dwm-setup in the 
<loadpoint>/install/unix directory to have Pro/ENGINEER make 
the appropriate changes for you. 

Specify resources in the /usr/lib/X11/app-defaults/4DWm and 
/usr/lib/X11/app-defaults/Toolchest files. Updates can also be 
made in the $HOME/.Xresources file as well as in files for individual 
users. 

Overlay Planes
Systems from Silicon Graphics must be equipped with a graphics adapter 
with at least four overlay planes, and the 4Dwm windowing environment 
should be used. To avoid unnecessary damage to the underlying graphics 
windows, Pro/ENGINEER uses the overlays for the user interface. SGI 
systems with four or more overlay planes can support the user interface 
in the overlay.

Sun Microsystems, Inc.
Machine configuration changes may be necessary to run PTC software on 
Sun Microsystems machines. For complete details, see 
www.sun.com/technical-computing/ISV/PTCFaq.html.
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Overlay Planes
A Creator3D or Elite3D graphics adapter is required for the use of overlay 
planes. In addition, the overlay visual must be the default visual. Use the 
command:

ffbconfig -propt

to determine if overlay is the default visual. If overlay is not your default 
visual, you must set overlay visual as the default visual.

How to Set Overlay Visual as the Default Visual
1. In a command window, log in as root on the machine to be set.

2. Enter the command:

ffbconfig -defoverlay true

3. Log out as root from the command terminal and restart the session 
manager.

Setting the Gamma Correction Value
Default colors can appear washed out in a Pro/ENGINEER installation 
on a Sun workstation. To rectify this, run the set_solaris_gamma 
script in the <loadpoint>/bin directory. Running the 
set_solaris_gamma script sets the gamma correction value for the 
graphics card to 1.5 from the default value of 2.20.

Pro/ENGINEER in X Windows
Information on using Pro/ENGINEER in a UNIX X Windows 
environment follows. 

Display Devices Supported
Pro/ENGINEER operates in an X Windows environment on computers 
from the following companies: 

• Hewlett-Packard

• SGI

• Sun Microsystems, Inc.

Using the Node-locked License option, the display device must be the 
same machine as the license (the X-client Pro/ENGINEER and the 
X-server must be running on the licensed machine).
System Administration Information B-5 



However, for those who use floating licenses, the display device and the 
computer running Pro/ENGINEER can be different. For example, you 
can use an HP as a server running Pro/ENGINEER and an SGI as the 
display device. Only the display device counts as a user against the total 
number of licenses available.

You can also use an X-terminal as the display device. In this case, you 
must ensure that the display terminal can properly display 
Pro/ENGINEER.

Running on a Remote Computer
In a floating license configuration, all the computers listed previously 
may be used as X display devices. To run Pro/ENGINEER on one 
machine and the X-server on another, follow the instructions from the 
manufacturer. 

How to Start Pro/ENGINEER on a Remote System
1. On the X-server, open a window and set xhost+.

2. From the X-server, log in remotely to the machine on which you want 
to execute Pro/ENGINEER.

3. On the remote machine, type:

If using csh:

setenv DISPLAY <xserver_machine_name>:0

If using sh: 

DISPLAY=<xserver_machine_name>:0
export DISPLAY

4. Run Pro/ENGINEER.

X-Terminal Path Name and Command
When running in an X Windows environment, Pro/ENGINEER needs the 
X Windows terminal emulator command used to open system windows 
for editing relations, entering datum point arrays, and so on. The full path 
name and the command must be provided for your system. For example, 
the command for Solaris is shelltool. Enter the path and name: 
/bin/shelltool. 

Use the configuration file option:

terminal_command_path_and_name
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Pro/ENGINEER through OpenGL
You can enable remote display of OpenGL to start Pro/ENGINEER only 
when you work across two computers that use the same UNIX operating 
system. PTC recommends that you run the same OpenGL library versions 
on both these computers. If the OpenGL library versions are different on 
two computers with the same UNIX operating system, Pro/ENGINEER 
does not use OpenGL to start up but instead uses X Windows. In this 
case, a warning message in the Pro/ENGINEER Startup window 
indicates that performance may be affected.

Note
Remote display of OpenGL is possible only on platforms that are 
certified to run Pro/ENGINEER.

PTC recommends a fast ethernet connection to use OpenGL 
remotely. This enhances the performance of graphical operations 
such as preselection highlighting, sketcher, and so on.

Graphics Configuration
For Pro/ENGINEER graphics support information, refer to the PTC 
Hardware Configuration Notes. Connect to the PTC home page at 
www.ptc.com/partners/hardware/current/proe.htm#gi

General Plotter Information
PTC supplies software that writes plot files in plotter format. You can 
specify a plot command in the config.pro file. The physical 
connection, however, is the responsibility of the computer and plotter 
vendors, because they are hardware and system software experts. 
Depending on the hardware configuration, the system software may 
require a different setup. 

In general, connection to the plotter is by RS232 cable with null modem 
configuration (pins 2 and 3 reversed, pin 7 ground). If this is the 
connection, the computer and plotter communicate using xon and xoff. It 
is usually necessary on UNIX to establish an entry in /etc/printcap to 
let UNIX know the characteristics of the connection. A typical printcap 
entry is as follows: 

hp7585|plotter|hp:\ 

:lp=/dev/ttyb:sd=/usr/spool/lpd:br#9600:\

:sf:pl#0:pw#0:mx#0:sh:lf=/usr/adm/lpd-errs:
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If you have difficulty in set up, contact the customer support department 
of your hardware vendor. 

Note
Pro/ENGINEER does not support any HPIB interfacing.

Loading and Mounting the CD-ROM on UNIX
Most UNIX systems mount the CD-ROM after it is loaded into  
the CD-ROM drive. For users whose machines do not mount 
automatically, the following instructions explain how to load and mount 
the CD-ROM locally and remotely.

Note
Sun Solaris 2.x has automatic CD mounting. For information specific 
to how PTC products run on Sun Microsystems hardware, visit 
www.sun.com/technical-computing/ISV/PTCFaq.html. This site 
also describes how to edit the config.pro file to adjust 
Pro/ENGINEER fonts. 

On Sun Solaris, after you have mounted the CD-ROM, you cannot 
unmount it if:

– You have started PTC.Setup using the CDE File manager.

– The PTC.Setup help is open.

Determining the SCSI ID of the CD-ROM Drive
You specify the SCSI identification number of your CD-ROM drive when 
you mount the CD-ROM file system to your UNIX workstation.

If you already know the SCSI ID of your CD-ROM drive, proceed to the 
next section, How to Load and Mount the CD-ROM Locally.

For external CD-ROM drives, the SCSI ID can be found on the back of 
your CD-ROM drive. Look for a single-digit switch. The displayed 
number is the SCSI ID number.
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For internal CD-ROM drives, use the following table to find the 
command or commands you need to enter to determine the SCSI ID of 
the CD-ROM drive (the bold # is the ID).

1Replace <device> with each item in the /dev/dsk directory.
Note
The inclusion of a platform in this table does not indicate support 
for that platform. This information is included to help you 
determine the SCSI ID for CD-ROM drives that is remotely 
mounted to your workstation. See the Hardware Configuration 
Notes for information on supported systems and platforms.

How to Load and Mount the CD-ROM Locally
1. Turn on the CD-ROM drive and insert the CD-ROM.

2. If the /cdrom directory does not already exist, create it using the 
following command:

mkdir /cdrom

3. Use the next table to find your UNIX workstation platform. Enter the 
command listed for your platform to mount the CD-ROM drive. 
Substitute the crosshatch (#) with the SCSI ID of your CD-ROM drive 
(see Determining the SCSI ID of the CD-ROM Drive).

Platform Command and Output SCSI ID 

HP HP-UX Insert the CD-ROM into the drive and use the diskinfo 
command.

Become root user.

For each file in the /dev/rdsk directory, at the command line type

/etc/diskinfo /dev/rdsk/<device file name>1

for the device file identified as type:CD-ROM. The SCSI ID is to 
the right of the letter t in this example of a device file name, 
c0t3d0. Note that the identified device file name is the same file 
name that is used in the command to mount the CD-ROM.

SGI IRIX hinv | grep CDROM

CDROM: unit 3 on SCSI controller 0

3 

(unit #)

Platform CD Device Mounting Commands

HP1 /etc/mount -F cdfs -o ro,cdcase /dev/dsk/c?t#d0a /cdrom

SGI MTFS2 mount -t iso9660 -o ro /dev/scsi/sc0d#l0b /cdrom
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1 Replace the question mark (?) with the Interface Card Instance Number 
and replace the crosshatch (#) with the device’s SCSI ID number.

2 The SGI device name uses the lowercase alpha character l, not the 
numeric 1.

How to Load and Mount the CD-ROM Remotely
Note
Mount the CD-ROM drive using NFS version 2. In machines that 
support NFS 3, an extra argument must be added to the mount 
command to force the use of NFS 2. 

1. Load and mount the CD-ROM on the remote UNIX system to which 
the CD-ROM drive is connected. Use the procedure in the section, 
How to Load and Mounting the CD-ROM Locally.

2. Before a remote UNIX system can allow access to the CD-ROM from 
your local UNIX workstation, you must export the CD-ROM file 
system. A line needs to be added to a file on your local UNIX 
workstation and, in some cases, a command needs to be executed.

3. Use the following table to look up the platform of the remote UNIX 
system and add the line in the Line to Add column to the file in the 
File to Edit column. You need write permissions to edit the files.

4. After you have made the changes, if necessary, execute the command 
listed in the Command column.

5. If the /cdrom directory does not already exist on your local UNIX 
workstation, create it using the following command:

mkdir /cdrom

6. You mount the CD-ROM mount directory from the remote UNIX 
system to your local workstation. Use the following table to look up 
the platform of your local UNIX workstation and execute the 
command for your UNIX platform. In the command you execute, 
substitute <node> with the name of the remote UNIX system to 

Platform File to Edit Line to Add Command

HP-UX /etc/exports /cdrom -ro exportfs /cdrom

SGI /etc/exports /cdrom exportfs /cdrom

SUN /etc/dfs/dfstab share -F nfs -o 
ro /cdrom

shareall
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which the CD-ROM drive is connected and substitute <cdmount> 
with the CD-ROM mount directory used on the remote UNIX system.

1 If you experience problems using PTC.Setup from a remote-mounted CD-ROM, 
you can try remounting the remote CD-ROM for SGI and Sun systems using the 
command
mount -o ro,hard,vers=2 <node>:<cdmount> /cdrom

Installing Libraries
Some applications come with libraries of models or textures for use in 
your models. For Pro/ENGINEER, all libraries except the Electrical 
Symbol, the Piping and Heating Symbol, and graphic libraries must be 
installed under the Pro/ENGINEER installation directory. The following 
subdirectories are automatically created in this common installation 
directory for each of the following libraries:

• Objlib—Basic Library

• Connlib—Connector Library

• Fittinglib—Pipe Fitting Library

• Hmflib—Human Factors Library

• Mfglib—Tooling Library

• Moldlib—Moldbase Library

Note
The Electrical Symbol Library and the Piping and Heating 
Symbol Library must be installed into a directory called 
library_syms in the symbols directory of your 
Pro/ENGINEER installation directory.

If you are updating your installation, make sure that the installation 
directory you have chosen does not contain any models that you want to 
save. During an update installation, any library files you enter in the 
installation directory are deleted and replaced with the current version of 
the library you install. You might want to back up your existing library 
installation before updating it. 

Platform Remote Mounting Command

HP /etc/mount -o ro,hard <node>:<cdmount> /cdrom

SGI1 mount -o ro,hard <node>:<cdmount> /cdrom

SUN1 mount -o ro,hard <node>:<cdmount> /cdrom
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To install a library:

1. After starting PTC.Setup with the appropriate library CD-ROM, 
choose the library name from the list of available software 
components.

2. Click Next to confirm that you are installing that library.

3. Click Next.

4. Specify the following information:

– Destination Folder—A default installation directory has been 
specified. 

Note
For new installations, the directory you enter must be a new 
directory. If you specify an existing installation directory, 
PTC.Setup updates the software in that directory. A 
subdirectory under the main installation directory is 
recommended (for example, C:\ptc\libraries).

– Under Features to Install, click  before each of the 
components and provide the following information:

Product Features—Choose the components that you want to 
install by clicking  next to the appropriate component. 
Select one of the following commands from the list:

Install this feature—Install the component. 

Do not install this feature—Do not install the component.

Platforms—Select the platform for the installation. Your 
machine's architecture is automatically detected and selected as 
the default platform.

Languages—Select the required language.

5. After you have selected your components, click Install. The 
Installation Progress screen displays the status of installation. You 
can also do one of the following operations:

– Click Cancel to cancel the installation.

– Click Back and review information. 

Further configuration is required to access the installed library files. 
B-12 Installation and Administration Guide



Using Fonts in Pro/ENGINEER
PTC provides 42 third-party TrueType fonts and the default PTC fonts 
with your software. In addition, you can also use any TrueType font 
available on Windows. The third-party TrueType fonts include 13 
different font styles. If you are running Chinese Traditional or Chinese 
Simplified Pro/ENGINEER, you can use two additional TrueType fonts:

• Chinese Traditional

– Monotype Hei Medium

– Monotype Sung Light

• Chinese Simplified

– Monotype HeiGB Medium

– Monotype SungGB Light

New fonts appear in the current font list in Pro/DETAIL and Sketcher. 
PTC fonts are listed first, followed by the third-party fonts supplied by 
Agfa Corporation. 

Note
Only fonts provided by PTC are supported in Sketcher for the 
creation of features.

TrueType fonts are stored in the <loadpoint>/text directory. You can 
change this default location by placing the fonts in another directory and 
setting the value of the pro_font_dir config.pro option to this 
directory. Pro/ENGINEER uses the fonts in the directory specified by the 
pro_font_dir config.pro option.

The new TrueType fonts and their corresponding file names follow:

Font Name File Name

Blueprint MT bluprnt.ttf

Blueprint MT Bold bluprntb.ttf

CG Century Schoolbook schlbk.ttf

CG Century Schoolbook Bold schlbkb.ttf

CG Century Schoolbook Bold Italic schlbkbi.ttf

CG Century Schoolbook Italic schlbki.ttf

CG Omega cgomg.ttf
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CG Omega Bold cgomgb.ttf

CG Omega Bold Italic cgomgbi.ttf

CG Omega Italic cgomgbit.ttf

CG Times cgtime.ttf

CG Times Bold cgtimebd.ttf

CG Times Bold Italic cgtimebi.ttf

CG Times Italic cgtimeit.ttf

CG Triumvirate trium.ttf

CG Triumvirate Bold triumb.ttf

CG Triumvirate Bold Italic triumbi.ttf

CG Triumvirate Condensed Bold triumcb.ttf

CG Triumvirate Italic triumi.ttf

Garamond garamd.ttf

Garamond Bold garamdb.ttf

Garamond Italic garamdi.ttf

Garamond Kursiv Halbfett garamdbi.ttf

Garth Graphic gargra.ttf

Garth Graphic Black gargrabl.ttf

Garth Graphic Bold Italic gargrabi.ttf

Garth Graphic Italic gargrai.ttf

Grotesque MT grotesq.ttf

Grotesque MT Bold grotesqb.ttf

Microstyle Extended microex.ttf

Microstyle Extended Bold microexb.ttf

Font Name File Name
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If required, you can purchase additional TrueType fonts. For information, 
contact the Agfa Monotype Corporation at www.agfamonotype.com.

When you work with Pro/ENGINEER, you use two categories of fonts: 

• Pro/ENGINEER fonts—These fonts appear in Pro/ENGINEER 
graphics windows. They define alphanumeric characters and special 
symbols in text files. You can edit these files by:

– Modifying the look of existing characters and symbols 

– Adding new symbols to the files 

– Creating new fonts 

• Hardware fonts—These fonts appear in Pro/ENGINEER window 
headers. They are machine- and language-specific.

Available System Fonts
To specify the font for menu items, set the configuration file option 
menu_font. The value for this option is the name of the font file, 
supported by the X-server running Pro/ENGINEER. To obtain the list of 
available fonts on UNIX machines, use the xlsfonts command. On 
Windows systems, the available fonts are listed in the Control Panel 
under Fonts. The font for text in Pro/ENGINEER window headers is 
determined by the current setting of your window manager.

Neographik MT neograph.ttf

Sackers English Script sackengs.ttf

Shannon shanno.ttf

Shannon Bold shannob.ttf

Shannon Extra Bold shannoeb.ttf

Shannon Oblique shannoo.ttf

Spartan Four MT sparton4.ttf

Spartan One Two MT sparton12.ttf

Spartan One Two MT Bold sparton12b.ttf

Symbol symbol.ttf

Triumvirate Inserat triin.ttf

Font Name File Name
System Administration Information B-15 

http://www.agfamonotype.com


Extended ASCII Set
ASCII is the default font in all Pro/ENGINEER modules. You can modify 
ASCII characters. You can also replace ASCII with your own font as the 
default. 

The extended ASCII character set used in the United States and Western 
Europe is supplied by Pro/ENGINEER through a combination of two 
font files, ascii.src and latin_1.src.

Note
Characters through 146 are defined in ascii.src. The remaining 
characters are defined in latin_1.src.

To use the European LATIN_1 characters, do one of the following 
procedures:

• Make sure your keyboard is set up for the appropriate language. A 
specific set of LATIN_1 characters is available with each keyboard 
language setting. 

• Use a key sequence specific to your machine type to produce the 
desired character. If necessary, contact your hardware vendor for 
additional information.

Displaying the Text Symbol Palette
To display the Text Symbol palette:

1. Open a drawing and click Insert > Note to create a note.

2. Select a location on the drawing to place the note. The Text Symbol 
palette appears.

3. Click on a symbol in the palette.

Alternatively, you can create a new symbol. Pro/ENGINEER represents 
special symbols with standard ASCII characters.

To use special symbols in drawing notes, follow these steps:

1. Enter the sequence CTRL+A.

2. Enter the ASCII character that represents the special symbol.

3. Enter the sequence CTRL+B.

When you create a new symbol, you should either redefine an existing 
character to the new symbol or create a new special symbol font. You can 
add new special symbols to the font file, special.src, by defining the 
graphic representation.
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Exporting Special Symbols to IGES
Special symbols and their corresponding ASCII characters map to the 
IGES font table 1001. Only two symbols (Total Runout and the Least 
Material Condition) do not map to the 1001 table. They are supported by 
the 1003 font table. The configuration file option use_iges_font_1003 
determines which IGES font table outputs data to IGES.When you assign 
an ASCII character to a new symbol, select a character from either the 
1001 or 1003 font table. Use 1001 or 1003 exclusively when you anticipate 
that a drawing will be exported in an IGES file. (Refer to your IGES 
documentation for more information on IGES font tables.)

How to Edit Pro/ENGINEER Fonts or Create New Fonts
1. Edit an existing or create a new .src file, which resides in 

<loadpoint>/text/<language>.

2. Compile the font file by using the command compile_font.

3. Make the new font available locally or for all users.

How to Modify a Pro/ENGINEER Font File
1. Copy the appropriate .src font file into your working directory. The 

.src files reside in <loadpoint>/text/<language>.

2. Modify the font file.

3. From the <loadpoint>/text/<language> area, copy the 
appropriate index file to your working directory.

4. Copy the compile_font command to your working area. If you are 
working on a UNIX machine, copy the executable compile_font to 
your working directory. The executable is in the following directory: 
<loadpoint>/<machine_type>/obj.

5. To compile the font, enter the following command for each font file 
you modify: compile_font fontfilename.src 
fontfilename.fnt 

Note
If you modify the ASCII font definitions, it alters the appearance 
of the default font in every Pro/ENGINEER module. 

How to Create a User-Defined Font File
1. Define a new font in a file with the extension .src. Store the new 

font in your working directory.

2. Create an index file that includes the new font file. Make sure the 
index file contains fonts with unique codesets.
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3. Copy the compile_font command to your working area. If you are 
working on a UNIX machine, copy the executable compile_font 
from <loadpoint>/<machine_type>/obj into your working 
directory. 

4. Enter the following command for each font file you create: 
compile_font fontfilename.src fontfilename.fnt 

5. Recompile user-defined fonts whenever you install a new major 
release of Pro/ENGINEER.

You can include user-defined fonts as default or auxiliary fonts in 
drawings.

How to Store a New Font
1. Store the updated index file with the .src and .fnt files in your 

local directory if the new font is for your personal use. 

2. To make a new font available to all users, reference the font in the 
index and store the index and source files in the directory 
<loadpoint>/text/<language>. Store the .fnt file in the 
following directory: 
<loadpoint>/<machine_type>/text/<language>

How to Set Your Font as the Default
1. Rename your file to ascii.src.

2. Recompile the ascii.src file using the compile_font command 
to produce a local ascii.fnt file.

How to Create or Customize a Font
1. Copy or create font source files in the local working directory. In this 

example, the default primary ASCII and special symbol fonts are 
copied and renamed.

cp /usr/pro/text/usascii/ascii.src custom.src 

(primary font with codeset 0) 

cp/usr/pro/text/usascii/special.src symbols.src 

(special symbols font with codeset 4) 

2. Edit the source files to include all the required definitions and 
changes.

vi custom.src 

vi symbols.src 
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3. Copy the compile_font script from the directory 
<loadpoint>/<machine_type>/obj into the same local working 
directory.

cp /usr/pro/sgi/obj/compile_font 

4. Compile the font files. 

compile_font custom.src custom.fnt 

compile_font symbols.src symbols.fnt 

5. Create a new index file to reference the compiled font files. Note that 
the index file name does not need to be the same as the primary font 
name. If the custom font created is not a primary font (codeset 0), be 
sure to include a font with a codeset of 0 in the index file. In this 
example, the new font index file references both customized font files 
(primary and special symbols).

myfont.ndx (new customized .ndx file) 

custom (new custom primary font (codeset 0))

latin_1 (system extended ASCII font(codeset 2))

symbols (new special symbols font (codeset 4)) 

This font index file references the new customized special symbols 
font only. It uses the system default primary font. 

myfont2.ndx (new customized .ndx file) 

ascii (system default primary font (codeset 0)) 

latin_1 (system extended ASCII font (codeset 2)) 

symbols (new special symbols font (codeset 4)) 

You can use the new font in the following ways: 

•  For personal use of the new font, leave the .src, .fnt, and .ndx 
files in your local directory. Then reference the new font index file 
name in the detail setup file as an auxiliary font.

aux_font # myfont

In this command, # is the auxiliary font number (1 through 8). 

• To use the font as a global auxiliary font, place the .src and .ndx 
files in the <loadpoint>/text/<language> directory. 
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Then put the compiled .fnt files in the directory 
<loadpoint>/<machine_type>/text/<language>.

mv custom.src symbols.src myfont.ndx 
/usr/pro/text/usascii 

mv custom.fnt symbols.fnt /usr/pro/sgi/text/usascii 

• To set the new font as the system default, rename the primary source 
and compiled font (codeset of 0) files to ascii.src and 
ascii.fnt, respectively. The system font.ndx file already references 
the ASCII font file and, therefore, does not need to be modified. 
Locate the new ascii.src and ascii.fnt files in the appropriate 
directories (see the previous section that describes how to use the font 
as a global auxiliary font). Note that the system overrides the original 
ascii.src and ascii.fnt files, unless you first rename them. 

The next time you start Pro/ENGINEER, it uses the new custom font 
as the system default font. 

mv custom.src /usr/pro/text/usascii/ascii.src 

mv custom.fnt /usr/pro/sgi/text/usascii/ascii.fnt 

Setting Language Defaults
Pro/ENGINEER supports English, French, Italian, German, Spanish, 
Chinese (Simplified and Traditional), Korean, and Japanese characters, 
with English as the default language. 

Note
Structural and Thermal Simulation supports only English, French, 
German, and Japanese characters.

To run the installation utility and Pro/ENGINEER in a language other 
than English, set the value of the system language environment variable, 
LANG, before you start the installation process. To set the value of the 
system language environment variable LANG, see Setting the System 
Language Environment Variable on page B-21 . 

To run Pro/ENGINEER in a language other than the default language set 
by the system language environment variable LANG, set the standard 
language environment variable PRO_LANG. To set the value of the 
environment variable PRO_LANG, see Setting the Standard Language 
Environment Variable on page B-25 .
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Setting the System Language Environment Variable
To run Pro/ENGINEER in a language other than English, set the value of 
the system language environment variable LANG before you start 
Pro/ENGINEER. The default value of the LANG variable is obtained from 
the local platform setting. Setting the value of the LANG variable is 
essential because some languages, especially the Asian languages, use the 
system fonts and local system values.

• For Windows: 

set LANG = <language>
where <language> is the language specification for your platform.

Note
On Windows 2000 and Windows NT systems, you can also set 
the language environment variable by clicking Start > Settings > 
Control Panel > System. In the System Properties dialog box, 
click the Environment tab. Specify LANG in the Variable box and 
the appropriate language variable, for example, French, in the 
Value box.

• For UNIX (C Shell):

setenv LANG <language>
where <language> is the language specification for your platform. 
UNIX settings are case-sensitive.

Note
Pro/ENGINEER and Pro/INTRALINK must be run in the same 
language.

The following tables list the values that you can specify for the LANG 
environment variable for different languages on different platforms.

Platform
Chinese 
Simplified

Chinese
Traditional French German

HP
HP-UX

zh_CN.hp15CN zh_TW.big5 c-french
c-french.iso88591
fr_CA.iso88591
fr_FR.iso88591
fr_FR.iso885915@
euro
french
french.iso88591

de_DE.iso88591
de_DE.iso885915
@euro
german
german.iso88591
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SGI
IRIX

zh_CN.eucgbk
zh_CN.gbk
zh_CN.ugb

zh_TW.big5 fr
fr_BE
fr_BE.ISO8859-15
fr_CA
fr_CA.ISO8859-15
fr_CH
fr_CH.ISO8859-15
fr_FR.ISO8859-15

de
de_AT
de_AT.ISO8859-15
de_CH
de_CH.ISO8859-1
5
de_DE.ISO8859-1
5

SUN
SOLARIS

chinese
zh
zh_CN.EUC

big5
tchinese
zh_TW
zh_TW.BIG5
zh_TW.big5

fr
fr_BE
fr_BE.ISO8859-1
fr_BE.ISO8859-15
fr_BE.ISO8859-
15@euro
fr_CA
fr_CA.ISO8859-1
fr_CH
fr_CH.ISO8859-1
fr_FR
fr_FR.ISO8859-1
fr_FR.ISO8859-15
fr_FR.ISO8859-
15@euro

de
de_AT
de_AT.ISO8859-1
de_AT.ISO8859-15
de_AT.ISO8859-
15@euro
de_CH
de_CH.ISO8859-1
de_DE
de_DE.ISO8859-1
de_DE.ISO8859-1
5
de_DE.ISO8859-
15@euro

Microsoft
Windows

chinese-
simplified
chs

chinese-
traditional
cht

french german

Platform
Chinese 
Simplified

Chinese
Traditional French German
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Platform Italian Japanese Korean

Default italian japanese korean

HP
HP-UX

it_IT.iso88591
it_IT.iso885915@euro
italian
italian.iso88591

ja_JP.eucJP
japanese.euc

ko_KR.eucK
R

SGI
IRIX

it
it_CH
it_CH.ISO8859-15
it_IT.ISO8859-15

ja_JP.EUC ko_KR.euc

SUN
SOLARIS

it
it_CH
it_IT
it_IT.ISO8859-15
it_IT.ISO8859-15@euro

ja
ja_JP
ja_JP.eucJP
japan
japanese

ko
ko_KR.EUC
korean

Microsoft
Windows

italian japanese korean

Platform Spanish English

Default spanish C

HP
HP-UX

es_ES.iso88591
es_ES.iso885915@euro
spanish
spanish.iso88591

C.iso88591
en_GB.iso88591
en_US.iso88591
english
english.iso88591

SGI
IRIX

es
es_AR
es_AR.ISO8859-15
es_ES.ISO8859-15
es_MX
es_MX.ISO8859-15

en
en_AU
en_AU.ISO8859-15
en_CA
en_CA.ISO8859-15
en_GB.ISO8859-15
en_US
en_US.ISO8859-15
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SUN
SOLARIS

es
es_AR
es_BO
es_CL
es_CO
es_CR
es_EC
es_ES.ISO8859-15
es_ES.ISO8859-15@euro
es_GT
es_MX
es_NI
es_PA
es_PE
es_PY
es_SV
es_UY
es_VE

en
en_AU
en_AU.ISO8859-1
en_CA
en_CA.ISO8859-1
en_GB
en_GB.ISO8859-1
en_GB.ISO8859-15
en_GB.ISO8859-
15@euro
en_IE
en_IE.ISO8859-1
en_IE.ISO8859-15
en_IE.ISO8859-
15@euro
en_NZ
en_NZ.ISO8859-1
en_UK
en_US
en_US.ISO8859-1
en_US.ISO8859-15

en_US.ISO8859-
15@euro

Microsoft
Windows

spanish C

Platform Spanish English

Platform German

HP
Linux

de_AT
de_AT@euro
de_CH
de_DE
de_DE@euro
german
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Setting the Standard Language Environment Variable
To run Pro/ENGINEER in a language other than the default language set 
by the system language environment variable LANG, set the value of the 
standard language environment variable PRO_LANG. For example, to run 
Pro/ENGINEER in the French language, on a system with English as the 
default system language, set the value of the standard language 
environment variable PRO_LANG to french. 

To run Pro/ENGINEER in a language other than the default system 
language, it is recommended to set the value of the standard language 
environment variable PRO_LANG instead of setting the value of the 
system language environment variable LANG. 

The value of the environment variable PRO_LANG supersedes the value of 
environment variable LANG when you run Pro/ENGINEER.

• For Windows

set PRO_LANG = <language>
where <language> is the required language, for example, french.

• For UNIX (C shell)

setenv PRO_LANG <language>
where <language> is the required language, for example, french.

Values that you can specify for the environment variable PRO_LANG 
include:

Language Value

French french

German german

Italian italian

Spanish spanish

Chinese Simplified chinese_cn

Chinese Traditional chinese_tw

Korean korean

Japanese japanese
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Using Asian Language Input Method Switch Keys
When you use the Asian languages along with English, you can switch 
the language input mode between the Asian language and English. Use 
the sequence of keystrokes in the next table to switch the input mode 
language.

Platform Language Key Sequence

HP Chinese Simplified Right META (Use the Right ALT key if no META key on 
the keyboard) for English to Chinese Simplified

Left META (Use the Left ALT key if no META key on the 
keyboard) for Chinese Simplified to English

F9  F10 

F11  F12 

SHIFT+F9  SHIFT + F10 (Big5)

SHIFT+F11  SHIFT+F12 

Chinese Traditional CTRL+SPACE Chinese Traditional to English

SHIFT+SPACE  input Switch

F9  F10 

F11  SHIFT+F11  (Big5)

SHIFT+F9 

Korean Right ALT to activate Korean mode

Left ALT to deactivate Korean mode

Japanese  or Extend Char or Left ALT to activate or 
deactivate Japanese mode

F9 Hirakana Input F10 Katakana Input

SPACE or  to convert to Kanji
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SGI Chinese Simplified CTRL+SPACE to switch between Chinese and English 
input 

F1  Switch

F2  Switch

F3  Switch

F5 

Chinese Traditional CTRL+SPACE to switch between Chinese and English 
input 

F1  F2 

F3  F4 

F5  F6 

F7  F8  input Switch

F9  Switch

Korean CTRL+SPACE to activate or deactivate Korean 
(no conversion necessary)

Japanese CTRL+ \ to activate or deactivate

CTRL+ k to toggle between Hirakana and Katakana 
Input

CTRL+ w to convert to kanji

Platform Language Key Sequence
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SUN Chinese Simplified CTRL+ SPACE to switch between Chinese and English 
input 

F2  F3 

F4  F5 

F6  F7 

Chinese Traditional CTRL+SPACE to switch between Chinese and English 
input 

F5  F6 

F7  F8 

F9  F10 

F11  F12 

Korean CTRL+SPACE to activate or deactivate Korean input (no 
conversion necessary)

Japanese  or CTRL+SPACE to activate or deactivate 
Japanese

SPACE to convert to Kanji

Windows Chinese Simplified CTRL+SHIFT to activate or deactivate Chinese input

Chinese Traditional CTRL+SHIFT to activate or deactivate Chinese input

Korean Right ALT to activate or deactivate Korean input (no 
conversion necessary)

Japanese ALT+  or ALT+~ to activate or 
deactivate Japanese input

SPACE to convert to Kanji

Platform Language Key Sequence
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Modifying the Configuration File for Multiple Languages
The configuration file, config.pro, controls many attributes of a 
Pro/ENGINEER session. The following table lists the attributes and their 
values for languages in the config.pro file:

config.pro Attribute Value Description

MENU_TRANSLATION YES (default) Displays menus in the set language

NO Displays menus in English

BOTH Displays menus in both English and the set 
language

HELP_TRANSLATION YES (default) Displays help in the set language

NO Displays help in English

MSG_TRANSLATION YES (default) Displays messages in the set language

NO Displays messages in English

DIALOG_TRANSLATION YES (default) Displays dialog boxes and top menus in the set 
language

NO Displays dialog boxes and top menus in English

SET_MENU_WIDTH <integer> Sets the menu width

DXF_IO_SJIS

(From Pro/ENGINEER 
2000i2 only)

NO (default) Imports or exports DXF file in EUC

YES Imports or exports DXF file in SJIS
System Administration Information B-29 



For example, if you set the value of the MENU_TRANSLATION attribute to 
BOTH in the config.pro file, then the Pro/ENGINEER menu appears in 
English and in the set language. The following figures show the 
Pro/ENGINEER menu in both English and in the set language, when you 
set the value of the MENU_TRANSLATION attribute to BOTH.

Meeting Pro/ENGINEER Browser Requirements
The following sections describe the requirements for the Pro/ENGINEER 
browser. You can find information on Web browser support for 
Pro/ENGINEER at 
www.ptc.com/partners/hardware/current/proewf2.htm. For 
information on Web browser support for the Help system, see Viewing 
the Help Center on page 8-2.

Browser Requirements for Windows
On Windows systems, you must have Internet Explorer version 6.0 with 
Service Pack 1 or later installed. When you start a Pro/ENGINEER 
session, Pro/ENGINEER checks for an installation of a compatible 
version of the Internet Explorer browser. 

English and Japanese English and French
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If this browser is not found, an error message appears and the 
Pro/ENGINEER session starts with the Pro/ENGINEER browser 
disabled.

The Pro/ENGINEER browser inherits the existing settings of Internet 
Explorer.

Browser Requirements for UNIX
When installing Pro/ENGINEER on UNIX systems, an embedded 
version of the Mozilla browser is automatically installed. This browser 
has its own profile directory, at $HOME/.ptcm140/ptc-browser. 
Pro/ENGINEER does not use any existing settings of a separate Mozilla 
installation. To change the settings of this Pro/ENGINEER browser, click 
Tools > Browser Options in the Pro/ENGINEER window. The 
Mozilla-native Preferences dialog box opens.

Opening a PDF File within the Pro/ENGINEER Browser
You can view a PDF document in the Pro/ENGINEER browser using 
Adobe Acrobat Reader. On Windows, Adobe Acrobat Reader is available 
as a plug-in. On UNIX, use Adobe Acrobat Reader as a helper application 
to view the PDF document in the browser. 

Follow these steps to register the Adobe Acrobat Reader as the helper 
application on UNIX.

1. When you open a PDF file for the first time, the following dialog box 
opens:

2. Select the Open using an application option. You can choose to clear 
the Always ask before opening this type of file option.
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3. Click Advanced. The following dialog box opens:

4. Specify a description for the file type and .pdf as the file extension.

5. Click Choose and browse to the path for the acroread command in 
the Adobe Acrobat Reader load point.

6. Click OK.

7. Click OK again, to complete the registration of Adobe Acrobat 
Reader as a helper application on UNIX.

In the current and all future sessions of Pro/ENGINEER you can directly 
view the PDF document in the Pro/ENGINEER browser using Adobe 
Acrobat Reader.

Printing a PDF Document
You can view a PDF document in the Pro/ENGINEER browser using 
Adobe Acrobat Reader. To print the PDF document, click the Adobe 
Acrobat Reader Print icon instead of the Pro/ENGINEER browser Print 
icon.

Setting Up ProductView Express (PVX)
For a Pro/ENGINEER installation on Windows, when you visit a Web 
page that has Pro/ENGINEER objects selected, the ProductView Express 
installer opens. Perform the following steps to install ProductView 
Express:

1. In the PTC ProductView Express Setup dialog box, click Next. The 
license agreement window opens.

2. Accept the license agreement to proceed. The User Information 
dialog box opens.
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3. Specify your full name in the Full Name box and the organization in 
the Organization box. If you have appropriate permissions, you can 
choose to make this ProductView Express setup available to yourself 
or anyone else who uses this workstation.

4. Click Next. The Destination Folder dialog box opens.

5. Specify the destination folder to install ProductView Express or keep 
the default value.

6. Click Next. The Start Installation dialog box opens.

7. Click Next. A window opens indicating successful installation of 
ProductView Express.
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8. Click Finish.

When installation is complete, ProductView starts without your having to 
restart the Pro/ENGINEER session.

With ProductView Express installed, if you update to a later 
Pro/ENGINEER date code, then upon startup of Pro/ENGINEER, 
ProductView Express is installed automatically without displaying the 
user interface.

The Pro/ENGINEER objects that you can open using ProductView 
Express follow:

File Extension File Type

.asm Pro/ENGINEER Assembly file

.dft Pro/ENGINEER Draft file

.dgm Pro/ENGINEER Diagram file

.drw Pro/ENGINEER Drawing file
B-34 Installation and Administration Guide



On Windows, double-click a file with a registered PVX extension to open 
the file in Internet Explorer.

Opening Pro/ENGINEER Objects from Windows 
Explorer

If you have not installed PVX, you can open a Pro/ENGINEER object 
directly from Windows Explorer in a Pro/ENGINEER session. 
Pro/ENGINEER objects typically appear with a PTC icon in Windows 
Explorer. Double-click an object in Windows Explorer to open it in a 
Pro/ENGINEER session. 

If you have installed PVX, a Pro/ENGINEER object is opened in Internet 
Explorer only for viewing when you double-click the object in Windows 
Explorer. Right-click on the object and choose Open with 
Pro/ENGINEER to open the object in Pro/ENGINEER. 

You can open objects with the following file types:

.frm Pro/ENGINEER Format file

.pic Pro/ENGINEER Picture file

.prt Pro/ENGINEER Part file

.rep Pro/ENGINEER Report file

.mfg Pro/ENGINEER Manufacturing file

.sec Pro/ENGINEER Sketcher Section file

File Extension File Type

File Extension File Type

.asm Pro/ENGINEER Assembly file

.dgm Pro/ENGINEER Diagram file

.drw Pro/ENGINEER Drawing file

.frm Pro/ENGINEER Format file
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Objects other than those listed in the preceding table do not open in 
Pro/ENGINEER.

If a Pro/ENGINEER session is already running and you double-click an 
object in Windows Explorer, the object is automatically loaded within the 
same Pro/ENGINEER session in a new window. This new window 
becomes the active window.

If a Pro/ENGINEER session is not running and you double-click an 
object in Windows Explorer, the Pro/ENGINEER startup config file 
dialog box opens. You are prompted to select a file from the list of 
available Pro/ENGINEER configuration files. Upon selecting the 
required startup configuration file, a Pro/ENGINEER session is started 
using the selected configuration file. The selected object is loaded in this 
Pro/ENGINEER session.

If multiple sessions of Pro/ENGINEER are running, the selected object is 
loaded in the session that was started first.

.lay Pro/ENGINEER Layout file

.mfg Pro/ENGINEER Manufacturing file

.mrk Pro/ENGINEER Markup file

.prt Pro/ENGINEER Part file

.sec Pro/ENGINEER Sketcher Section file

File Extension File Type
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JavaScript Security
In Pro/ENGINEER, a JavaScript bridge is used so that the JavaScript code 
inside a displayed HTML page interacts with Pro/ENGINEER. For 
example, Feature info reports, folder content listings, and new 
connection registrations all use the JavaScript bridge for security 
purposes.

Pro/ENGINEER automatically activates the JavaScript bridge only from 
pages generated by Pro/ENGINEER or Windchill Solutions. If a page 
generated from another source tries to access Pro/ENGINEER through 
the JavaScript bridge, the following warning message appears and the 
operation is stopped.

Take one of the following actions:

• If the URL in the message is from an unreliable source, contact your 
system administrator and avoid accessing this page again.

• If the URL in the message is from a reliable source, such as a PTC 
Windchill Solution, contact Technical Support.

Adding Connection Instances in the Connections 
Navigator

The Connections navigator provides quick access to the PTC solutions 
and services, or other frequently used Web pages. Default connections 
appear as top-level nodes in the Connections tree as shown in the next 
figure. When a new PTC solution or service is available on the PTC Web 
site, or you want to frequently access a particular Web page, you can add 
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connections, or buttons, for these Web pages to the Connections 
navigator. Use the JavaScript code described later in this section to add 
connections.

A Connection Instance is a node below a top-level connection on the 
Connections tree. A Connection Instance can have multiple child 
Connection Instance nodes, but only one parent node. Each Connection 
Instance is either a direct or an indirect child of top-level connections.

When you select a connection from the Connections navigator, the 
associated Web page opens in the Pro/ENGINEER browser. A 
corresponding tab is added to the browser menu bar. When you return to 
a connection, the page that you visited last on that connection opens in 
the browser.

Using the JavaScript Code
To add a Connection Instance to the Connections tree, add the following 
JavaScript code to a Web page and open the Web page in the 
Pro/ENGINEER browser.

<script>

// -- The JS bridge

function ProExec(cmd)

{
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   if  ( top && top.external && top.external.ptc )

       return top.external.ptc(cmd);

   else

      return null;

}

function ProECommandVoid(cmd) { ProExec ("0" + cmd); }

//--Adding Connection Instance node to Connections tab

function PTC_AddConnectionInstance(name, parent, 
label, icon, url )

{

   ProECommandVoid("conn_add_instance?" + name + "?" + 
parent + "?" + escape(label) + "?" + escape(icon) + "?" 
+ escape(url));

}

</script>

This JavaScript code defines the PTC_AddConnectionInstance 
function, which is an API application. 

You can pass the following parameters to the 
PTC_AddConnectionInstance function:

• name—The unique name of the Connection Instance that you want to 
add. The name must be unique. This name identifies the node for 
further use and does not appear in the Connections tree.

• parent—The name of the parent connection or Connection Instance 
under which you want to add the new Connection Instance. The 
parent connection must exist prior to adding the new Connection 
Instance. The names of the top-level default connections, such as 
Projects, Catalogs, or User Area are the same as their labels that 
appear in English. For example, to add a Connection Instance under 
the Catalog top-level connection, specify the value of the parent 
parameter as Catalog.

• label—The label of the Connection Instance that you want to add. 
This label appears in the Connections tree.

• icon—The icon that you want the added Connection Instance to use. 
This icon can be the location of a .gif file that is available for 
download or one of the two default icons provided by PTC, that is, 
3party_node or use_from_parent. Specify use_from_parent 
to use the same icon as that of the parent connection. 
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The icon size must be 16x16 pixels. The size is automatically adjusted 
when the icon is displayed in the Connections tree.

Note
You must specify only a .gif file for the icon. Any other file 
format is not supported.

• url—The location of the Web page associated with the Connection 
Instance that you want to add. This Web page opens in the 
Pro/ENGINEER browser when you select the added Connection 
Instance on the Connections tree.

Note
The Connection Instance is not added if you do not correctly 
specify all the parameters of the JavaScript function 
PTC_AddConnectionInstance.

Example of Adding a Connection Instance
For example, the following is the HTML code of a Web page that displays 
three buttons. Opening this page in the Pro/ENGINEER browser and 
clicking the three buttons adds two Connection Instances under the 
Project connection and one under the Catalog connection.

<html>

<head>

<title>Adding Connection Instance</title>

<script>

// -- The JS bridge

function ProExec(cmd)

{

   if ( top && top.external && top.external.ptc )

      return top.external.ptc(cmd);

   else

      return null;

}

function ProECommandVoid(cmd) { ProExec("0" + cmd); }

//--Adding Connection Instance node to Connection tab
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function PTC_AddConnectionInstance(name, parent, 
label, icon, url)

{

   ProECommandVoid("conn_add_instance?" + name + "?" + 
parent + "?" + escape(label) + "?" + escape(icon) + "?" 
+ escape(url));

}

function add_Projects_ConnectionInstance()

{

PTC_AddConnectionInstance( "MyProject", "Projects", 
"My Project Label", "use_from_parent", "www.ptc.com")

}

function add_Sub_Projects_ConnectionInstance()

{

PTC_AddConnectionInstance( "MySubProject", 
"MyProject", "My SubProject Label", "3party_node", 
"www.ptc.com")

}

function add_Catalogs_ConnectionInstance()

{

PTC_AddConnectionInstance( "MyCatalog", "Catalogs", 
"My Catalog Label", "3party_node", "www.ptc.com")

}

</script>

</head>

<body>

<br>

<input type=button id="b1" value="Add My Project" 
onClick='add_Projects_ConnectionInstance()'</input>

<br>

<input type=button id="b2" value="Add My SubProject" 
onClick='add_Sub_Projects_ConnectionInstance()'</input
>
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<br>

<input type=button id="b3" value="Add My catalog" 
onClick='add_Catalogs_ConnectionInstance()'</input>

</body>

</html>

Note
In this example, you can add the Connection Instance 
MySubProject only after you add its parent Connection Instance, 
MyProject.

The following figure shows the Pro/ENGINEER Connections tree after 
adding the three nodes defined in the previous example.
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Distributed Computing

Technology
This appendix contains information on the Distributed Computing 
technology that is used by Pro/ENGINEER to augment your existing 
hardware.

Topic Page

Overview C - 2
Supported Functions C - 2
Configuring Workstations for Distributed Computing C - 3
Specifying Host Machines for Distributed Computing C - 4
C-1 



Overview
Pro/ENGINEER uses Distributed Computing technology to augment 
your existing hardware to perform computationally intensive tasks. 
Distributed Computing technology includes the following items:

• A Pro/ENGINEER session or the controller.

• Participating networked workstations.

• A daemon running on each participating workstation.

• One or more agents running on the workstations. These agents could 
be the Pro/ENGINEER sessions running as server processes.

• A task or a collection of jobs.

Note
Distributed Computing is suitable only for multiobject design 
studies.

Interactions between the Controller and the Agent
With Pro/ENGINEER you can optimize the distribution of tasks using 
Distributed Computing technology. The controller communicates with 
the daemon on each workstation and determines load averages. Agent 
sessions are automatically started depending on load averages and the 
number of processors. These agents are started only once for every 
distributed computing task and not for every job. Communication of data 
is also optimized. Data, that is, models, information, and instructions, are 
efficiently streamed directly to each agent through the daemon. No files 
are copied to a workstation before a job is carried out. As subsequent jobs 
are dispatched to the same agent, only data that is different between the 
jobs is streamed. If the data involved is the same, it is not streamed again.

Supported Functions
Distributed Computing technology supports the following functions:

• Workstations with multiple CPUs are leveraged so that an agent 
process exists for every CPU (depending on the system load average).

• Workstations are engaged in distributed computing unless the load 
on a CPU exceeds 20 percent.
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• During distributed computing, tasks are dispatched to workstations 
based on real-time conditions, which include the following:

– The workstations must be online.

– The load average on the workstations must be within permissible 
limits. The load average is calculated over time, not with a single 
measurement at a specific point in time. 

• If a workstation shuts down during distributed computing, the active 
task is not interrupted. The controller detects the shutdown and 
routes the job to another agent. 

• If multiple users are performing distributed computing tasks, 
workstations are engaged on a first-come, first-served basis. While a 
workstation is processing jobs dispatched by a certain controller, it is 
unavailable to other controller sessions.

After the controller completes its task, any active controller can then 
engage the workstation.

Note
Avoid using distributed computing when dispatching jobs across 
fire walls.

Configuring Workstations for Distributed 
Computing

As system administrators, after installing Pro/ENGINEER 2000i2 or later, 
you must configure workstations for distributed computing by 
performing the following tasks:

1. From the available UNIX and Windows workstations, choose the 
ones that can participate in distributed computing sessions.

2. Run the dcadsetup script on each participating workstation. This 
script starts a daemon process that is required for distributed 
computing. No other setup task is required.

3. To shut down the daemon process and thus disable a workstation 
from participating in distributed computing sessions, run the 
dcadshutdown script. 

4. Optionally, register the dcadsetup command within the boot script 
of a workstation. This step ensures that the workstation is enabled for 
distributed computing after it is shut down and restarted.
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Specifying Host Machines for Distributed 
Computing

You can specify the host machines for distributed computing by using the 
Distributed Computing Hosts Selection dialog box that opens when you 
click Tools > Distributed Computing in a Pro/ENGINEER session. 
Distributed computing tasks automatically use the dialog box settings. 

When you begin a task, a progress bar indicates the progress of the task, 
statistics about how many jobs are being processed by agents on each 
participating workstation, and the status of each workstation. You can 
release the participating workstations at any time for use by others for a 
distributed computing task.
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Troubleshooting Tips
This appendix documents common problems that occur when you install 
PTC software and PTC License Server. This appendix also provides 
general debugging techniques and cites other sources of information 
available from the PTC Web site.

Topic Page

General Debugging Hints D - 2
Online Information D - 2
Troubleshooting List D - 2
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General Debugging Hints
The log file, ptclmgrd.log, records license server activities and can be 
found in ptc/flexlm/licensing/ptclmgrd. This file has useful 
information that you should check when you have a problem.

Online Information
See www.ptc.com/support/index.htm for a wealth of how-to 
information for new and experienced users, including order and license 
support. The Technical Support link provides online tools and other 
support services. You can search the Knowledge Base of over 14,000 
technical documents or download reference documents, including the 
Read This First.

The PTC Customer Service Guide and contact support is available under 
Related Links. For information on FLEXlm diagnostic environment 
variables, consult the FLEXLm End Users Guide. 

Troubleshooting List
Scan through the following list of problems to find any that appear to be 
the same as the one you are experiencing. The information is presented in 
the following format.

Symptom: Describes the problem.

Cause: Lists the cause of the problem.

Solution: Provides steps to resolve the problem.

Failure to Start the Software
Symptom: On Windows systems, when you attempt to start your PTC 
software, you see an MS-DOS window that contains the message: 
Cannot find 
<Installation_Directory>\<mc_type>\filename 

Cause: The system PATH, an environment variable, is either not set to the 
<Installation_Directory>\bin or it is improperly set due to a 
syntax or spelling error.

Solution: Check the system PATH. 
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Xtop Icon Disappears from the Taskbar
Symptom: An Xtop icon appears for a few seconds in the taskbar and 
quickly disappears. 

Cause: Network configuration settings are not properly set.

Solution: Make sure that the network settings are in accordance with the 
Suggested Technique for Configuration of a Windows Workstation for 
executing Pro/ENGINEER (found at www.ptc.com/cs/cs_20/howto/
win515/win515.htm)

Look for a file in the startup location called std.out and see if there are 
references to network errors. If there is a line that states Exception 
Code Was -1073741819, make sure the latest graphics driver is 
installed. The most recent graphics driver can be downloaded from the 
manufacturer's Web site. An alternative is to set the config.pro option 
graphics win32_gdi.

Inaccurate Ptcstatus Command Information
Symptom: On Windows systems for Release 20 and later, the ptcstatus 
command returns the following message, 
Displaying status for license file 77880@ptc Warning 
(-15): Cannot connect to license servers (-15, 10; 
10061).

Cause: The license server is not running or the license client cannot reach 
the server.

Solution: Verify that the lmgrd and ptc_d daemons are running. A 
network problem exists if a license client attempts to ping the server by 
host name and the ping fails.

Invalid Licenses
Symptom: You receive the error message Invalid license. 

Cause: Licensing information is inaccurate.

Solution: Return to the FLEXlm license editor and verify that the 
information entered is exactly as it appears in your License Pack. If no 
licenses are listed, return to the FLEXlm license editor and ensure no text 
is highlighted.

If all licenses are listed as invalid, verify that the PTC Host_ID in the 
License Pack corresponds with what you see in the FLEXlm license 
editor. For example, one server line and one daemon line represent a 
single server. Three server lines and one daemon line represent a 
fault-tolerant or Triad configuration. Remove all the lines that do not 
pertain to the PTC HOST_ID. 
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Your incremental lines must have no blank lines. Verify that all 
continuation characters (\) are at the end of each line, except for the last 
line. If some licenses are valid while others are invalid, find the invalid 
feature name lines in the License File window and correct the text.

If you received your license codes via e-mail, remove any extraneous text 
such as the header and footer. Another option is to delete the invalid 
license in the FLEXlm license editor window.

FLEXlm Fails to Start (Triad Configurations)
Symptom: PTC License Server does not start after a Triad server is 
installed and configured.

Cause: The following requirement has not been met: two of the three 
partners of the Triad configuration must be running (Quorum) before 
licenses can be distributed.

Solution: Go to a shell window or a command prompt and change into 
the <FLEXlm_Installation_Directory>\bin. Type in 
ptcstartserver.
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Glossary
Application Program Interface (API)   A set of standards or conventions by 
which programs can call specific operating system or network services.

commercial license   The license you get when you purchase PTC software for 
commercial purposes.

counted locked license   Although a locked license is managed by a FLEXlm 
license server, its usage is restricted to a machine for which it is licensed. 
The license server allows customers to use up to the number of licenses 
purchased at one time.

datecode   A unique number to identify a specific version of PTC software. The 
datecode can be found printed on the jacket of the software CD-ROM.

daemon line   An entry in the license file that defines
• The name of the PTC daemon, which is a customized software 

program that grants and denies floating PTC licenses by 
reading the license file

• The path where this executable resides, that is in the FLEXlm 
installation directory

• The path to the FLEXlm options file, which contains various 
operating parameters

Design Animation   A software extension that enables users to create animation 
sequences of parts and assemblies from within Pro/ENGINEER.

educational license   A license used at educational institutes to run PTC 
software, also known as a students license. This is a time-bound license.

evaluation license   An evaluation license allows use of a software product for a 
trial period.

FLEXlm   The license management software that is used to distribute licenses. 
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feature line   The feature or increment line is an entry in the license file that 
describes the product that the user is allowed to use, as well as any 
optional software products that are associated with that license. 
Following is a sample of the feature line: 
INCREMENT PROE_FlexEng ptc_d 23.0 01-jan-02 4\ 
AC0C6BED48DABD0CA081 VENDOR_STRING="VSVER=2.0 \
LO=(0,3,6,7,10,17,32,34,51,55,62,66,69,73,106,\
126,133,163)" \
SUPERSEDE vendor_info="VIVER=1.0 EXTERNAL_NAME=" \
ISSUER=PTC ISSUED=29-jun-2002 NOTICE="BMW_AG, \
137661" SN=23134

feature name   The feature name is the name of the license that the application 
requests. It is composed of a product prefix and a configuration ID (for 
example, PROE_FlexEng).

floating license   A floating license can be used on more than one system. 
Floating licenses are distributed by a license server process that runs on a 
machine. This machine is also called the license server. See license-to-run.

hardware reconfiguration   The process of changing any aspect of the machines 
currently mapped to the Configuration ID.

increment line   See feature line.

installation directory   The directory in which PTC software is installed. Also call 
the load point.

install number   A number used by the PTC order management system before 
October 20, 1997, to identify a single software installation.

license   A license grants a user permission to run a PTC product.

license borrowing   A functionality of FLEXlm 8.4a or later. You can borrow 
licenses from a license server and run a licensed application on a remote 
client without being connected to the license server.

license client   A machine or software session that requests a license from 
another machine or software session. For example, if you start 
Pro/INTRALINK on machine A and it requests a license from license 
server B, then machine A is a license client.

license file   The file (license.dat) that is saved onto the user's disk when 
FLEXlm is installed and configured. This file contains the information 
used by FLEXlm to authorize the use of software.

license information   The information that is used by FLEXlm to authorize the 
use of software. Also used to describe the information that is contained in 
the PTC License Pack, particularly before a customer has imported or 
entered that information into the FLEXlm license file. (for example, Enter 
the license information into the editor).
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license-locked   Refers to an optional module for use with a specific licensed 
product, which may be either floating or node-locked. If an optional 
module is license-locked to a node-locked license, it may only be used on 
the specifically authorized machine. If an optional module is 
license-locked to a floating license, it may be used on any machine in the 
network (in conjunction with that license).

license-locked option   An optional module of PTC software that is locked to a 
license of PTC software. When the license is successfully started, all 
license-locked options associated to the licenses are available.

license management   The PTC organization responsible for all 
installation-based activities.

license management software   See FLEXlm.

license pack   The packet sent to a customer (either by e-mail, fax, or U.S. mail) 
that contains the license codes necessary to run your software.

license-to-run   A license-to-run invokes the license of a specific PTC 
application, such as Pro/ENGINEER. Floating licenses are available for 
use on any host machine on the network at any particular site. See 
floating license.

license server   A machine or system process that distributes licenses to license 
clients. For example, if you start Pro/ENGINEER on machine A and it 
requests a license from machine B, then machine B is the license server. 
The license server keeps track of the number of licenses in use. A system 
administrator can use a license server to control licenses by placing 
restrictions on a particular feature.

load point   Directory where the software is installed. An example of the 
Pro/ENGINEER load point on UNIX systems is 
/usr/local/proewildfire2.0. On Windows it could be 
C:\Program Files\proeWildfire2.0.

lmgrd daemon   The FLEXlm license manager daemon (lmgrd) runs on the 
license server and works with the PTC vendor daemon. It does not 
manage license usage. The lmgrd daemon starts vendor daemons, refers 
applications to the appropriate vendor daemon, and communicates with 
other lmgrd daemons on the network (for Triad installations).

maintenance release request   A request for postproduction PTC software, 
which features enhancements after a major new revision. 

maintenance shipment   An update to the next major release of PTC software.

Macrovision Corporation   Owner of FLEXlm, a license management software. 
Further information is available at www.macrovision.com.

ModelCHECK   A software productivity tool for Pro/ENGINEER, 
ModelCHECK analyzes parts, drawings and assemblies, and 
recommends proper Pro/ENGINEER modeling techniques.
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name_service daemon (nmsd)   This daemon process enables remote 
communication between Pro/ENGINEER and other PTC applications.

node-locked license   A license that can be used on only one specific machine or 
node. Node-locked licenses are restricted to a specific Host ID, or CPU ID. 
If the node-locked license does not match the CPU ID of the machine 
running the software, then the license cannot be used on that machine. 
Node-locked licenses can be counted or uncounted.

part file   A file that contains Pro/ENGINEER part information (for example, 
object dimensions).

product prefix   This standard prefix corresponds to a particular product. For 
example, the product prefix for Pro/ENGINEER is PROE_. This product 
prefix might be used as a prefix within a feature name, such as 
PROE_12345, where 12345 is the Configuration ID; or for an environment 
variable, such as PROE_FEATURE_NAME, which designates the feature 
that Pro/ENGINEER requests on startup.

Pro/BUNDLE   A type of floating optional module that is comprised of several 
existing optional modules. PTC licensing recognizes the bundled 
software as a single licensed entity.

Pro/ENGINEER   A 3-D mechanical design automation suite, Pro/ENGINEER 
provides associative and interoperable product design and an 
engineering modeling system.

Pro/J.Link   A Java-based toolkit, Pro/J.Link allows developers to create Java 
applications that access a Pro/ENGINEER session.

Pro/Plastic Advisor   Pro/Plastic Advisor simulates mold filling for injection 
molded plastic parts and provides designers with immediate, easy access 
to reliable manufacturing feedback and advice.

Pro/TOOLKIT   An API, Pro/TOOLKIT enables customers and third parties to 
add functionality to Pro/ENGINEER using the C programming 
language. 

Pro/Web.Link   An API, Pro/Web.Link extends the capabilities of the Netscape 
browser so it can communicate with Pro/ENGINEER.

PTC Application Manager   A utility that appears as a toolbar that enables the 
user to start and close other applications during a Pro/ENGINEER 
session.

PTC.Setup   A graphical installation utility with common menus, dialog boxes, 
and screen icons to help customers install PTC product applications.

PTC.Setup Help   Online user installation instructions displayed in a Web 
browser.

PTC daemon   The PTC vendor daemon (ptc_d) runs on the license server and 
works with the FLEXlm daemon. It manages license usage by reading the 
PTC license file. The PTC daemon also contains the authentication 
information for PTC license security.
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PTC Host ID   The number used to uniquely identify your machine. This is the 
same number used in PTClm, called the CPU ID. Also referred to as the 
machine address.

reconfigurations   The process of modifying the configuration of software 
(moving modules from one license to another).

server line   An entry in the license file that identifies the server or servers that 
distribute the software.

startup command   The command that is used to start an installed software 
product. The startup command is created during installation and is 
associated with at least one license from the license management 
component. Modules that are in separate feature lines can also be 
associated with the startup command. When a startup command is 
executed, the associated licenses and modules are automatically licensed 
for use by the user who executed the startup command.

trail file   A trail file records the procedures the end user performed while 
running a Pro/ENGINEER session.

triad servers   A configuration of three license servers on the same network that 
work together to manage a pool of floating licenses.

uncounted node-locked license    A node-locked license whose permission to 
use the license is managed by the PTC application, not the license server. 
Unlimited number of uncounted node-locked license sessions can be run 
on a single machine at one time.

Web.Link   A Pro/ENGINEER feature, Web.Link lets you interact with 
Pro/ENGINEER through a Web browser. With this feature, you can create 
a customized Web page, which you can then use to automate and 
streamline aspects of your engineering process.
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